
www.grassvalley.com

XRE Transcoder

Users Guide

version 9.0

F0701803014
March 2018



2	 XRE Transcoder ―  Users Guide

Copyright Copyright © 2018 Grass Valley. All rights reserved. Portions of software 
© 2000 - 2018, Microsoft Corporation. All rights reserved. This document 
may not be copied in whole or in part, or otherwise reproduced except as 
specifically permitted under U.S. copyright law, without the prior written 
consent of Grass Valley USA, LLC, P.O. Box 59900, Nevada City, California 
95959-7900. This product may be covered by one or more U.S. and foreign 
patents.
Grass Valley is a trademark of GVBB Holdings S.a.r.l.

Disclaimer Product options and specifications subject to change without notice. The 
information in this manual is furnished for informational use only, is subject 
to change without notice, and should not be construed as a commitment by 
Grass Valley USA, LLC. Grass Valley assumes no responsibility or liability for 
any errors or inaccuracies that may appear in this publication.

U.S. Government 

Restricted Rights 

Legend

Use, duplication, or disclosure by the United States Government is subject 
to restrictions as set forth in subparagraph (c)(1)(ii) of the Rights in 
Technical Data and Computer Software clause at DFARS 252.277-7013 or in 
subparagraph c(1) and (2) of the Commercial Computer Software Restricted 
Rights clause at FAR 52.227-19, as applicable.

Trademarks and 

Logos
Grass Valley is a trademark of GVBB Holdings S.a.r.l. Grass Valley USA, 
LLC products are covered by U.S. and foreign patents, issued and pending. 
Additional information regarding Grass Valley USA, LLC trademarks and 
other proprietary rights may be found at www. grassvalley.com.

Other trademarks and logos used in this document are either registered 
trademarks or trademarks of the manufacturers or vendors of the associated 
products, such as Microsoft® Windows® operating system, Windows Media® 
player, Internet Explorer® internet browser, and SQL Server™. Grass Valley, 
GV STRATUS, K2, Aurora, Summit, Infinity, and EDIUS are either registered 
trademarks or trademarks of Grass Valley USA, LLC in the United States 
and/or other countries. QuickTime and the QuickTime logo are trademarks or 
registered trademarks of Apple, Inc., used under license therefrom. Adobe, 
Adobe logo, Flash and Flash logo, and Adobe Flash Player are trademarks 
of Adobe Systems Incorporated. Intel, Pentium, Xeon and Core Duo are the 
trademarks or registered trademarks of Intel Corporation or its subsidiaries 
in the United States of America and other countries. HDV is a trademark 
of Sony Corporation and JVC KENWOOD Corporation. XDCAM, XDCAM 
EX, XAVC, XAVC S, and SxS are trademarks of Sony Corporation. GF is 
a trademark of Toshiba Corporation. P2, AVCCAM, AVC-Intra, and AVC-
Ultra are trademarks of Panasonic Corporation. AVCHD is a trademark of 
Panasonic Corporation and Sony Corporation. Blu-ray is a trademark of Blu-
ray Disc Association. SD card is a trademark of SD Association. 



XRE Transcoder ―  Users Guide	 3

The trademark, service mark, product name logo, and product name of 
RED are trademarks or registered trademarks of Red.com, Inc. in the 
United States and other countries. Avid, Avid DNxHD, and Avid DNxHR 
are trademarks or registered trademarks of Avid Technology, Inc. or its 
subsidiaries in the United States. AMD is a trademark of Advanced Micro 
Devices, Inc. They are manufactured based on their own license.

Manufactured under license from Dolby Laboratories. Dolby and the double-D 
symbol are trademarks or Dolby Laboratories. Unpublished work. Copyright 
2003-2012 Dolby Laboratories, Inc. and Dolby Laboratories Licensing 
Corporation. All right reserved.

    

Grass Valley 
Web Site

This public Web site contains all the latest manuals and documentation, and 
additional support information. Use the following URL
http://www.grassvalley.com.

Manual 
Explanation

•	If there are any variations between the explanation in this manual and the 
actual application method, priority is given to the actual application method.

•	The screens used as examples in this manual are those of the development 
stage, so they may vary from those in the final product.

•	This manual is written for people who have a basic knowledge of how to 
use a computer. If there are no special instructions, perform the same 
operation as a normal computer operation.

•	In this manual, EDIUS Workgroup, EDIUS Pro, and EDIUS series are called 
“EDIUS”.

•	In this manual, Microsoft® Windows® operating system products are called 
as follows.
-- Microsoft® Windows® 7 operating system: Windows 7 (collective term for 
Ultimate, Enterprise, Professional, Home Premium, and Home Basic)
-- Microsoft® Windows® 8 operating system: Windows 8 (collective term for 
Enterprise, Pro, and Core Edition)
-- Microsoft® Windows® 8.1 operating system: Windows 8.1 (collective term 
for Enterprise, Pro, and Core Edition)
-- Microsoft® Windows® 10 operating system: Windows 10 (collective term 
for Enterprise, Education, Pro, and Home)

Revision Status Rev Date Description

October 31, 2016 Release F0701611012

March 16, 2018 Release F0701803014



4	 XRE Transcoder ―  Users Guide

Contents
1	 Before Using

Before Using����������������������������������������������������������������������������������6
System Requirements............................................................................6
Package Contents.................................................................................7
About This Manual................................................................................7

Grass Valley Product Support��������������������������������������������������������������8
Web Technical Support...........................................................................8
Phone Support.....................................................................................8
Authorized Support Representative............................................................9

2	 Overview

XRE Transcoder Overview���������������������������������������������������������������� 10

3	 Setup

Installing XRE Transcoder���������������������������������������������������������������� 11
Activation of Serial (Online)�������������������������������������������������������������� 12
Activation of Serial (Offline)������������������������������������������������������������� 13

4	 XRE Transcoder Settings

Setting Example���������������������������������������������������������������������������� 15
Configuring XRE Transcoder�������������������������������������������������������������� 16
Plug-in settings����������������������������������������������������������������������������� 21

[HEVC]............................................................................................ 23
[QuickTime]...................................................................................... 23
[GXF].............................................................................................. 24
[MPEG]............................................................................................ 25
[MXF]............................................................................................. 26
[XDCAM].......................................................................................... 27
[Dolby Digital]................................................................................... 28
[K2 (SAN)]........................................................................................ 29
[Cinema RAW]................................................................................... 31
[Sony Raw]....................................................................................... 31

5	 XRE Transcoder Operations

Specifying and Converting a File�������������������������������������������������������� 32
[Print to File] Dialog Box....................................................................... 35



XRE Transcoder ―  Users Guide	 5

Converting a File Automatically (Watch folder function)���������������������������� 44
Applying Project Template at Conversion���������������������������������������������� 50

Editing Example of Project Template (Watermark)........................................ 51
Editing Example of Project Template (Sidebar Blur)...................................... 53
Editing Example of Project Template (Playback Speed Change)........................ 56

Output Setting for Each Format���������������������������������������������������������� 59
Windows Media Video Format................................................................ 59
AVI Format........................................................................................ 61
Audio Format..................................................................................... 62
Dolby Digital Professional or Dolby Digital Plus Format................................. 63
HDV Format...................................................................................... 67
QuickTime Format............................................................................... 67
BD Format........................................................................................ 69
MP4 Format...................................................................................... 72
MPEG-2 Format.................................................................................. 73
Flash Video (F4V) Format...................................................................... 77
H.265/HEVC Format............................................................................ 77
AVCHD Format................................................................................... 78
XDCAM EX Format.............................................................................. 79
GF Format........................................................................................ 81
P2 Format........................................................................................ 83
XDCAM Format.................................................................................. 85
XAVC S Format.................................................................................. 87
XAVC Format..................................................................................... 88
K2 (GXF) Format................................................................................ 90
K2 (CMF) Format................................................................................ 94
MXF Format...................................................................................... 98

Registering Exporter Settings as Preset����������������������������������������������102
Checking job status�����������������������������������������������������������������������104

About error notifications......................................................................107
Checking job properties.......................................................................107
Sorting the order to perform jobs in XRE Transcoder (management mode).........109

6	 Appendix

Supported Format������������������������������������������������������������������������� 111
Input format.....................................................................................111
Output format...................................................................................113

Restrictions�������������������������������������������������������������������������������� 118



6	 XRE Transcoder ―  Users Guide

Section 1  ― Before Using

Section 1
Before Using

Before Using

System Requirements

�� OS
•	Windows 7 64‑bit (Service Pack 1 or later)
•	Windows 8/Windows 8.1/Windows 10 64‑bit
•	Windows Server 2008/Windows Server 2012

�� CPU
•	Intel Core 2, Intel Core iX CPU, or higher
•	Intel or AMD single core CPU with a 3 GHz processor speed or 

faster (multiple CPUs or multicore CPUs are recommended)
•	SSSE3 (supplementary SSE3) compatibility

�� Memory
•	16 GB RAM

�� Hard Disk
•	6 GB or more hard disk space required for installation

�� Network
•	Internet connection required for activation
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Before Using

Package Contents
Please verify that the following items are included in XRE Transcoder.
•	XRE Transcoder Installation DVD
•	Serial number
•	XRE Transcoder Users Guide (Download) (this book)

Note •	Activation cannot be performed without the serial 
number. Keep the serial number not to be lost. The serial 
number cannot be reissued for any reason.

About This Manual
This manual serves as Users Guide of “XRE Transcoder”, an optional 
product of EDIUS XRE.
In this manual, descriptions are given based on the premise that 
the system environment of EDIUS XRE Ver.9.0 or later has been 
constructed.
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Grass Valley Product Support
For technical assistance, to check on the status of a question, or to 
report a new issue, contact Grass Valley Product Support via e-mail, 
the Web, or by phone or fax.

Web Technical Support
To access support information on the Web, visit the product support 
Web page on the Grass Valley Web site. You can download software 
or find solutions to problems by searching our Frequently Asked 
Questions (FAQ) database.

World Wide Web:
www.grassvalley.com/support/contact

Local Support Centers:
www.grassvalley.com/ad/contact_customer_support

Phone Support
Use the following information to contact product support by phone 
during business hours. After hours phone support is available for 
warranty and contract customers.

United States/Americas +1 801 222 5204
Europe, United Kingdom, 
Africa and The Middle East

+44 (0)20 8867 6305

Asia (except Japan and 
Korea)

+86 21 5869 8668

http://www.grassvalley.com/support/contact
http://www.grassvalley.com/ad/contact_customer_support
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Grass Valley Product Support

Authorized Support Representative
To locate the support representative for your country, visit the Product 
Support Web page on the Grass Valley Web site: 
www.grassvalley.com/support. 
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Section 2  ― Overview

Section 2
Overview

XRE Transcoder Overview
XRE Transcoder adds the following functions to the EDIUS XRE 
system.
•	Format conversion process (transcoding job) of a desired file can be 

requested to EDIUS XRE without intermediate of EDIUS.
•	You can configure the settings so that a file is requested to be 

automatically processed for format conversion (as a transcoding job) 
once it is added in the Watched folder. (Watch folder function)

The controller manages the jobs to distribute the jobs to the engines, in 
the same way as on EDIUS XRE. See the EDIUS XRE Users Guide for 
more details.
The progress status of the transcoding jobs can be checked in the 
job list of XRE Transcoder. The job list shows jobs requested by 
XRE Transcoder, and also jobs from EDIUS clients. XRE Transcoder 
installed on the controller turns to XRE Transcoder (management 
mode), which is allowed to reorder the jobs to be executed.
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Installing XRE Transcoder

Section 3
Setup

Installing XRE Transcoder
Install XRE Transcoder to a PC that is within the EDIUS XRE system 
network.
It can be installed on either of the PC for controller, engine, or client.

Note •	You need to set up EDIUS XRE controller and engine in 
advance.

•	Close all other application software including resident 
software before installation.

•	Before installing the software on your PC, be sure to 
login with a user ID (such as Administrator) authorized 
to change system settings.

1	 Set your XRE Transcoder Installation DVD into the DVD drive.
Double-click “XreTranscoder_Setup-9.xxxxx.exe”.

2	 Click [Install].

The installation of XRE Transcoder begins.
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Section 3  ― Setup

3	 Click [Close].

Activation of Serial (Online)
Activation is performed after the complete of installation. Activation 
requires internet connectivity environment. The function installed 
when activation was not performed cannot be used. 

1	 Click the [start] menu, and then click [All Programs] > [Grass 
Valley] > [GV LicenseManager].

2	 Click [Online Activation] in the [License List] dialog box

3	 Enter a serial number, and click [OK].

Activation is complete.

POINT •	Activation in the offline environment is also possible.
Activation of Serial (Offline)►P13 
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Activation of Serial (Offline)

Activation of Serial (Offline)
If the install destination PC is not connected to the Internet, complete 
activation by using another PC with Internet connection to perform 
offlline authentication for activation.

1	 Connect a USB stick to the PC on which XRE Transcoder has 
been installed.

2	 Click the [start] menu, and then click [All Programs] > [Grass 
Valley] > [GV LicenseManager].

3	 Click [Offline Activation Create ID File] in the [License List] 
dialog box.

4	 Enter a serial number, and click [OK].

5	 Choose the USB stick as save location and then click [Choose 
folder].

6	 Click [OK].

7	 Eject the USB stick from the machine and then insert into a 
Windows PC connected to an internet.
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8	 Open the USB stick and then double-click [GVActivation].

9	 Click [Yes].

10	 Click [OK].

11	 Eject the USB stick from the Windows PC and then insert to 
the PC on which XRE Transcoder has been installed.

12	Click [Offline Activation Register Activation File] in the 
[License List] dialog box.

13	 Choose Response.key in the folder where the ID file of the 
USB stick has been exported, and then click [Open].

14	Click [OK].

15	Activated license will be listed. Close the window by clicking 
[X].
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Setting Example

Section 4
XRE Transcoder Settings

Before starting configuration of XRE Transcoder, the following 
environment must be prepared.
•	The PC for controller and PC for engine can be operated as the 

EDIUS XRE system.
•	The PC on which XRE Transcoder has been installed is connected to 

the PC for controller and PC for engine in a network via Ethernet.
See the EDIUS XRE Users Guide for more details.

Setting Example
In this section, each step is described based on the following system 
setting example.

�� Controller/Engine PC
¾¾Controller settings
(Use a computer name: XREServer, IP address: 172.25.90.161)

Project folder

Controller Project Folder (any folder name) on 
the Server
Ex. \\XREServer\XRE_Controller_Project_
Folder

Port 1223 (default)
Days to keep jobs in 
history

30 (default)

¾¾Engine settings

Node name Engine1 (any name)
Server setting

Name
XREServer (any name)

Address
“XREServer” (computer name of the PC where 
controller is installed) or “172.25.90.161”

Port
1223 (default)
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�� XRE Transcoder PC
¾¾XRE Transcoder settings

Server setting

Name
XREServer (any name)

Address
“XREServer” (computer name of the PC where 
controller is installed) or “172.25.90.161”

Port
1223 (default)

Configuring XRE Transcoder
Perform the following settings on the PC for XRE Transcoder.
•	Setting for connection to the controller
•	Setting for notifications of error that occurs in conversion process
•	Settings for the Watch folder

1	 Double-click the XRE Transcoder icon on the desktop.

Alternative
•	Click the [start] menu, and then click [All Programs] > [Grass Valley] 

> [XRE Transcoder].

2	 Click [Settings].

Alternative
•	Click [Settings] > [Setting] from the menu bar. 

3	 Click the [Settings] tree, and then click [Server setting].



XRE Transcoder ―  Users Guide	 17

Configuring XRE Transcoder

4	 Click [Add].

The [Server setting] dialog box appears.

�� 	[Server setting] Dialog Box

[Name] Type the name of the controller.
[Address] Enter the computer name or IP address of the PC you 

want to use as an controller.
[Port] Enter a port number. The default setting value is 1223.

Note •	You must specify a port number that is not blocked by 
the firewall. The firewall is turned off with the standard 
settings of a base PC.

•	For a system whose firewall is turned on for operations, 
the firewall setting must be changed to unblock the 
desired port number.

•	The system may not work properly if you specify a port 
number used by other programs. Therefore, you must 
specify an unused port number.

5	 Set each item, and then click [OK].
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Section 4  ― XRE Transcoder Settings

6	 Click [Apply].

POINT •		If you want to change any setting, select the server to be 
changed from [Server setting] list and click [Edit].

•		If you want to delete any setting, select the server to be 
deleted from [Server setting] list and click [Delete].

Continue to configure [Error notification].

7	 Click the [Settings] tree, and then click [Error notification].

�� 	[Error notification]



XRE Transcoder ―  Users Guide	 19

Configuring XRE Transcoder

[Error 
notification 
setting]

From the list, choose the type of errors you will 
be notified of.
If you choose [Notify errors of all jobs], you will 
be notified of errors related to all transcoding jobs 
instructed by the PC to each engine.
If you choose [Notify errors of my jobs], you will 
be notified of errors related to transcoding jobs 
requested by this Client itself.
If you choose [No error notification], no error 
notification will occur.
About error notifications►P107 

[When making 
an error, Beep is 
sounded.]

Check this option to make a beep sound when 
delivering error notifications.

8	 Set each item, and then click [Apply].

9	 To use the Watch folder function, click the [Settings] tree, and 
then click [Watch Folder].

�� 	[Watch Folder]
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[Output file name 
rules]

Set the name of the files output after 
conversion process.

[Source file name]
The file name will be “file name before 
conversion (+ extension)”.

[Date Time]
The file name will be “date and time at 
creation of output file (+ extension)”.

[Source file name _ Date Time]
The file name will be “file name before 
conversion_date and time at creation of 
output file (+ extension)”.

[If there is a file with 
the same name in the 
destination]

Set the action if there is a file with the same 
name (including the extension) in the output 
destination after conversion.

[Overwrite]
The file will be overwritten.

[Output file name _ Increment Number]
The output file will be named as “output 
file name_000 (3-digit increment number) (+ 
extension)” and saved.

[Existing files in the 
watch folder when 
(re)connecting to 
server]

Set how to process the files remaining in the 
Watch folder at the time of reconnecting to 
the controller.

[Convert files that were not converted previously]
Converts only files that have not been 
converted. Existing files to which errors 
occurred will no be converted.

[Convert files that were not converted previously 

and also files that failed to convert before]
Converts files that have not converted and 
existing files to which errors occurred.

[Don’t convert existing files]
Does not perform any process on existing files.

10	 Set each item, and then click [OK].
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Plug-in settings

Plug-in settings
Configure the plug-in settings (settings according to file types) as 
necessary.
If the file output destination after conversion is an FTP server or K2 
Media server, set the output destination in advance in the plug-in 
settings.

1	 Click the [Plug-in settings].

The [Settings] dialog box appears.

�� [Settings] Dialog Box

Note •	If the terminals for XRE Transcoder, controller, and 
engine are separate PCs, it is necessary that the plug-
in environment of all PCs are identical. If their plug-in 
environments are different, an error may occur or your 
data may not be exported properly.
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2	 Click the [Settings] tree, and then click an item to set.
For details on each item, see the following descriptions.

[HEVC]►P23 

[QuickTime]►P23 

[GXF]►P24 

[MPEG]►P25 

[MXF]►P26 

[XDCAM]►P27 

[Dolby Digital]►P28 

[K2 (SAN)]►P29 

[Cinema RAW]►P31 

[Sony Raw]►P31 

** The plug-in settings configuration is not supported for [AVCHD] and 
[Still image].

3	 Set each item, and then click [OK].
You can continue to configure other settings by clicking [Apply].
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Plug-in settings

[HEVC]
By utilizing hardware supporting the Quick Sync Video, you can 
decode the data with the video compression standards HEVC (H.265) 
with high-speed.

[Use Hardware 
decoder]

Check this item to use hardware decoding such as 
Quick Sync Video.

[QuickTime]
Use QuickTime for Windows to configure settings to use 3GP, 3G2, 
M4V, and other MOV files.
This is displayed only when QuickTime for Windows has been 
installed.



24	 XRE Transcoder ―  Users Guide

Section 4  ― XRE Transcoder Settings

[Enable 
QuickTime 
Importer]

Sources in the format described in “Restrictions 
after Uninstallation of QuickTime” can be
used.
Formats Added at Installation of QuickTime►P113 

[GXF]
Set the connections of FTP servers when outputting in the GXF format.

[Server] Display a list of addresses of FTP servers set as 
export destinations.

[Add] Click this item to display the [FTP settings] dialog 
box for adding connection servers.
[FTP settings] Dialog Box►P25 

[Delete] Delete servers from [Server].
[Modify] Change the server settings.
[Move Up]/
[Move Down]

Sort the servers.
Select a server from [Server] and move the 
selected server one place up or down with each 
click of [Move Up] or [Move Down].

[Settings] Display the settings of the connection selected in 
[Server].
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Plug-in settings

�� [FTP settings] Dialog Box

[Name] Enter the name set for the server.
[Address] Enter the IP address or server name of the FTP 

server.
[Port Number] Enter the port number. The default port number is 21.
[Directory] Enter the directory name of the export 

destination.
[Username]/
[Password]

Enter the user name and password required when 
making the connection.

[Connection 
Test]

Click this item to test the connection to the FTP 
server using the currently entered user name and 
password.

[MPEG]
Set faster seeking of MPEG files.

[Use Accel. Seek] Not supported.
[A/V 
Synchronization 
Using PTS]

Check this item to use the PTS (time stamp 
information) for synchronization of audio and 
video.
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[Get Timecode 
from GOP 
Header]

Some MPEG files may have timecode information 
in their header. Check this item to use timecode 
information.

[MXF]

�� [FTP Server]
Set the connections of FTP servers when outputting in the MXF 
format.
The [FTP Server] setting items for MXF are the same as for GXF.

[GXF]►P24 

�� [Decoder]
You can set the layer and downsample coefficient to be decoded when 
importing MXF files in the JPEG2000 format.

[Quality] Specify a layer to decode.

[High]
Decode all layers.

[Middle]
Decode half of the layers.

[Low]
Decode single layer.
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Plug-in settings

[XDCAM]

�� [FTP Server]
Set the connections of FTP servers when outputting in the XDCAM 
format.

[Server] Display a list of addresses of FTP servers set as 
export destinations.

[Add] Click this item to display the [FTP settings] dialog 
box for adding connection servers.
[FTP settings] Dialog Box►P28 

[Remove] Delete servers from [Server].
[Modify] Change the server settings.
[Move Up]/
[Move Down]

Sort the list.
Select a server from [Server] and move the 
selected server one place up or down with each 
click of [Move Up] or [Move Down].

[Settings] Display the settings of the connection selected in 
[Server].
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¾¾ [FTP settings] Dialog Box

[Name] Enter the name set for the server.
[Address] Enter the IP address or server name of the FTP 

server.
[Username]/
[Password]

Enter the user name and password required when 
making the connection.

[Directory] Select a directory type from the list.
[Connection 
Test]

Click this item to test the connection to the FTP 
server using the currently entered user name and 
password.

POINT •		If connection fails by the connection test, try restarting 
the XDCAM device and PC after completing the FTP 
server connection setup.

�� [Importer]
Not supported.

[Dolby Digital]
Make the settings for exporting Dolby Digital.

[Dynamic Range 
Control]

Set the operation mode of the dynamic range 
when Dolby Digital Professional and Dolby 
Digital Plus are imported.



XRE Transcoder ―  Users Guide	 29

Plug-in settings

[K2 (SAN)]

�� [Server]
Configure connection to K2 Media server.

[Configure 
automatically]

Check this item to automatically detect the server 
that can be used (K2 Media server).
If the server is not detected, uncheck this item and 
set manually.

[Server List] Display a list of servers (K2 Media server) set as 
export destinations.

[Add] Click this item to display the [Server settings] 
dialog box for adding connection servers.
[Server settings] Dialog Box►P30 

[Delete] Delete servers from [Server].
[Modify] Change the server settings.
[Move Up]/
[Move Down]

Sort the servers.
Select a server from [Server] and move the 
selected server one place up or down with each 
click of [Move Up] or [Move Down].

[Settings] Display the settings of the connection selected in 
[Server].
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�� [Server settings] Dialog Box

[Name] Enter the name set for the server.
[Host Name] Enter the IP address or server name of the server.
[Host Name 
(Backup)]

For redundant configuration, enter the IP address 
or server name of the server that is paired with 
[Address].

[Username]/
[Password]

Enter the user name and password required when 
making the connection.

[Domain] Enter the domain of the server.
[Mapped Path] Select the drive you assigned on the client PC side 

to the V: drive of the server.
[Show only 
SNFS drivers]

Normally, check this item.

[Connection 
Test]

Click this button to test the connection to the 
server with the settings entered in the [Server 
settings] dialog box.

POINT •	To use the product in stand-alone with K2 Summit, set 
the K2 Summit C: drive to be used for the network drive 
of the client PC. Check [Show only SNFS drivers] in the 
[Server settings] dialog box, and then select the assigned 
drive from the [Mapped Path] list.
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[Cinema RAW]

�� [GPU]
If there are supported GPUs, perform playback acceleration using 
hardware.

[Sony Raw]

�� [GPU]
If there are supported GPUs, perform playback acceleration using 
hardware.
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Section 5
XRE Transcoder Operations

Note •	Perform the initial settings of XRE Transcoder in advance 
according to Section 4 - XRE Transcoder Settings.

Specifying and Converting a File
On the PC for XRE Transcoder, specify a desired file and request 
conversion process (transcoding job) to the controller.
In this section, the procedure common to different output formats are 
described.

Note •	Make sure that the controller/engine is started up.
•	Confirm that the project folder of the XRE system can be 

referenced from the PC. In addition, make sure that the 
explorer of the project folder shows the same address as 
those of the controller and engine.

•	For details on the supported formats and restrictions, see 
Section 6.
Appendix►P111 

•	If the file output destination after conversion is an FTP 
server or K2 Media server, set the output destination in 
advance in the plug-in settings.
Plug-in settings►P21 

•	If the file output destination after conversion is an 
external device, connect the external device to the PC for 
engine, and confirm that the power is turned on.

1	 Double-click the XRE Transcoder icon on the desktop.

Alternative
•	Click the [start] menu, and then click [All Programs] > [Grass Valley] 

> [XRE Transcoder].
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2	 Click [Add job].

Alternative
•	Click [File] on the menu bar, and then click [Add job].
[New job] dialog box appears.

3	 Click [...] of [Source File:] to select a source file.

4	 To apply a project template at the time of conversion, check 
[Project Template], click [...], and select a project template 
(*.ezpt).

Applying Project Template at Conversion►P50 

5	 Click [...] of [Format Settings].

The [Print to File] dialog box appears.

[Print to File] Dialog Box►P35 

6	 Click a category in the category tree, and select an exporter.

See "Section 6" for the output formats and exporter list.

Output format►P113 
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7	 If the file sizes (frame sizes or frame rates) of source files and 
output files need to be changed, select the check box of [Enable 
Conversion], and click the expansion button of [Advanced] to 
configure the settings.

[Print to File] (Detailed Settings) Dialog Box►P38 

8	 Click [Export], and configure according to the on-screen 
instructions.

The setting items will differ depending on the exporter.

Output Setting for Each Format►P59 

9	 Specify a file name and saving destination.

10	 Click [Save] or [OK].

Note •	If the file output destination after conversion is a desired 
folder, you need to specify a folder that can be referenced 
from all of the PCs for XRE Transcoder/controller/engine 
and that shows an identical address on the explorer.

11	 Click [OK] on the [New job] dialog box.

The transcoding job is registered to XRE, and the conversion process 
is performed. The progress status of the conversion process can be 
checked in the job list of XRE Transcoder.

Checking job status►P104 

POINT •	The exporters can be registered as presets.
Registering Exporter Settings as Preset►P102 
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[Print to File] Dialog Box

(1) Category tree Select a category to narrow down the exporter 
options.

[Current default]
Display the default exporters.

[Recently used]
Display exporters in a list in the order of most 
recently used first.

[My presets]
Display the exporter presets registered by the 
user in a list.

[All]
Display all exporters in a list. You can narrow 
the exporter options by selecting a category 
by format.
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(2) Exporter/Preset 
list

Display the exporters within a selected 
category in a list.

[Preset]
Display exporter presets stored as default and 
exporter presets stored by the user.
Registering Exporter Settings as Preset►P102 

 : Video exporter
Indicates exporters to export a file that 
includes a video element.

 : Audio exporter
Indicates exporters to export an audio 
element.

 : A preset where conversion is performed
Check [Enable Conversion] to display all 
exporter presets including exporter presets 
with a format that differs from the source file.

(3) [Search] Search the exporters.
(4) [Export in 

16bit/2ch]
Check this item to perform export in 
16‑bit/2ch regardless of the audio format of 
the source file or selected preset exporter. It is 
convenient to leave it checked when a multi-
channel source file is to be exported and used 
with software by another manufacturer.

(5) [Enable 
Conversion]*

Check this item to enable conversion 
processing used to export in formats that 
differ from the source file.

(6) [Job setting]* [Priority]
Choose the priority from [High], [Normal], 
or [Low] in terms of the order to perform 
transcoding jobs. If you set the higher priority 
setting, the transcoding job will be processed 
with higher priority.

[Comment]
Enter a comment here.

(7) [Advanced] Click the expand button to configure 
conversion processing when exporting in a 
format that differs from the source file.
[Print to File] (Detailed Settings) Dialog 
Box►P38 
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(8) [Save as 
default]

Select an exporter in the exporter/preset list, 
and click [Save as default] to save the settings 
in [Current default].

(9) Preset operation 
buttons

 : [Save preset]
Register the exporter selected in the exporter/
preset list together with the conversion 
processing configured under [Advanced] as a 
preset exporter.
Registering Exporter Settings as Preset►P102 

 : [Delete preset]
Delete the preset exporter selected in the 
exporter/preset list.
The only exporter presets that can be deleted 
are those that have been registered by the 
user.

 : [Import preset]
Import exporter presets.

 : [Export preset]
Export the preset exporter selected in the 
exporter/preset list.

(10) [Export]/[OK] Output according to the configured settings.

** Not displayed in the [Print to File] dialog box of the Watch folder.

POINT •	To export a multi-channel source file to use with 
software by another manufacturer, either check [Export 
in 16bit/2ch] or select an exporter in 16‑bit/2ch audio 
format.
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�� [Print to File] (Detailed Settings) Dialog Box
If a preset exporter was selected, you will switch to the export format 
settings of that preset exporter.

¾¾Setting [Change Video Format]

Checking [Change Video Format] exports files converting to the video 
format set in the following items.
“*” in the right field of a setting indicates that the setting agrees with 
the source file.
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(1) Video profile 
list

Display a list of commonly used video 
formats. When you select a video format from 
the list, [Frame Size] and other items will 
switch to the selected video format settings.

(2) [Frame Size] Select a frame size from the list. Select 
[Custom] to enter a setting value in pixels.

(3) [Aspect Ratio] Select an aspect ratio from the list. If you 
select [Custom Display Aspect] or [Custom 
Pixel Aspect Ratio], you can set the aspect 
ratio by entering values. If you have set a 
customized aspect ratio, make sure to select 
a conversion method from the aspect ratio 
conversion setting.

(4) Aspect ratio 
conversion 
settings

If the aspect ratio set in [Aspect Ratio] differs 
from the source file, select which method to 
use to convert the aspect ratio from the list.
Setting the Aspect Ratio Conversion►P42 

(5) [Crop Overscan 
Area]

Check this item to convert the aspect ratio 
after cropping with the overscan size. The 
overscan size differs according to the source 
file.

(6) [Frame Rate] Select a frame rate from the list. If you have 
set a customized frame rate, be sure to 
select a conversion method in the frame rate 
conversion settings.

(7) Frame rate 
conversion 
settings

If the frame rate set in [Frame Rate] differs 
from the source file, select from the list which 
conversion to perform.
If you select [Frame blending], supplemental 
frames will be interpolated by combining the 
frame before and after each supplemental 
frame. If you select [Nearest frame], 
the nearest frame will be used to make 
supplementary frames.

(8) [Field Order] Select a field order from the list. If you select 
[Auto], the optimum perceived field order will 
be selected automatically.

(9) [Default TC 
Mode]

Select whether the video to be exported 
displays the drop frame timecode or the non 
drop frame timecode as default.
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(10) [Channel] This can be set when an exporter to which the 
alpha channel is retained and can be output 
to is selected.
Select whether to output only the color 
channel or to output the color channel and the 
alpha channel.

¾¾Setting [Change Audio Format]
Checking [Change Audio Format] changes the audio format so it 
is exported with the below-described items. However, if [Export in 
16bit/2ch] has been checked the [Channels] and [Sample Format] 
settings will be fixed.
“*” in the right field of a setting indicates that the setting agrees with 
the source file.

[Channels] Select the number of channels from the list. If the 
selected number of channels is fewer than the 
source file, the channels will be exported in order 
from 1ch. Select [2ch] to export a multi-channel 
source file to be used with software of another 
company.

[Sampling Rate] Select a sampling rate from the list.
[Sample 
Format]

Select an audio quantization bitrate from the list. 
Select [16bit] to export a multi-channel source file 
to be used with software of another company.

[Export Audio] Check this item to export the audio part.
[Create 
Waveform Cache]

Check this item to create waveform cache 
(waveform representation of audio).

¾¾ [Remove Ancillary data]
This can be set when a compatible exporter is selected. Check this item 
to export with ancillary data (including closed captions) removed.

Note •	Even if it is unchecked, when the frame size, after the 
frame rate or aspect ratio is corrected, is different from 
that of source file, ancillary data will be removed.

¾¾ [Remove Audio Bitstream]
This can be set when a compatible exporter is selected. Check this item 
to export with the audio bitstream removed.

Note •	Even if this item is unchecked, when the frame rate or 
audio sampling rate differs from that of the source file, 
audio bitstream will be removed.
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¾¾ [Normalize Loudness] setting
Checking this item enables to measure the loudness and perform 
normalization at the same time when you export a file.
For normalization, the volume can be adjusted according to a 
predefined loudness reference value.

(1) Loudness 
reference value

Select the preset to use as the reference for 
loudness measurement and normalization.

(2) [Output report 
file]

Check this item to export the loudness 
adjustment details and measurement result 
values of the target file to a text file.
The text file will be saved in the project 
folder of XRE system. If project files are to be 
exported to FTP or some other destinations, 
they will be saved in the “Log” folder in the 
project folder.

POINT •	Clicking [Save preset] in the [Print to File] dialog box 
will create an exporter preset that contains the setting 
details of [Normalize Loudness].

Note •	If the audio of the project to be normalized is muted 
or low, after a message [The audio adjustment level is 
too large.] is displayed, export may be canceled. This is 
performed to prevent low-volume sound such as noise 
from being unintentionally adjusted louder.

•	Normalization is only applied to source files with audio 
sampling rate 48 kHz. For sources with a sampling rate 
other than 48 kHz, normalization can be performed by 
first applying the project template set to “48kHz” for 
[Audio Preset] in the [Project Settings] (Detailed Settings) 
dialog box, and then converting it.
Applying Project Template at Conversion►P50 



42	 XRE Transcoder ―  Users Guide

Section 5  ― XRE Transcoder Operations

¾¾Setting the Aspect Ratio Conversion
For the items in the list of the aspect ratio conversion setting to be set 
in the [Print to File]/[Print to File] (Detailed Settings) dialog box, what 
follows are example descriptions of converting a 16:9 screen to a 4:3 
screen, and a 4:3 screen to a 16:9 screen.

Item

Original 
screen
→

Converted 
screen

Description

Letter box / 
Side panel

16:9 → 4:3 The 16:9 screen is displayed in the center 
of a 4:3 screen, and a letter box effect is 
added above and below.

4:3 → 16:9 The 4:3 screen is displayed in the center 
of a 16:9 screen, and side panels are 
added at the edges.

Side cut / 
Crop top 
and bottom

16:9 → 4:3 The left and right sides of the 16:9 screen 
are cropped to fit the 16:9 screen to a 4:3 
screen size.

4:3 → 16:9 The top and bottom parts of the 4:3 
screen are cropped to fit the 4:3 screen to 
a 16:9 screen size.
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Item

Original 
screen
→

Converted 
screen

Description

Anamorphic 16:9 → 4:3 The 16:9 screen is compressed 
horizontally to fit a 4:3 screen size. The 
frame aspect ratio is not conserved.

4:3 → 16:9 The 4:3 screen is stretched horizontally 
to fit a 16:9 screen size. The frame aspect 
ratio is not conserved.

Semi-
letter box 
(14:9/13:9)

16:9 → 4:3 The 16:9 screen is cropped to a 14:9 or 
13:9 screen size, displayed in the center 
of a 4:3 screen and a letter box effect is 
added above and below.

4:3 → 16:9 The 4:3 screen is cropped to a 14:9 or 13:9 
screen size, displayed in the center of a 
16:9 screen and side panels are added at 
the edges.
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Converting a File Automatically (Watch folder function)
You can configure the settings so that a file is requested to be 
automatically processed for format conversion (as a transcoding job) 
once it is added in the Watched folder.
The procedures to configure the Watch folder (Watched folder, output 
destination after conversion, and output setting) on the PC for XRE 
Transcoder are described.

Note •	Make sure that the controller/engine is started up.
•	Confirm that the project folder of the XRE system can be 

referenced from the PC. In addition, make sure that the 
explorer of the project folder shows the same address as 
those of the controller and engine.

•	For details on the supported formats and restrictions, see 
Section 6.
Appendix►P111 

•	If the file output destination after conversion is an FTP 
server or K2 Media server, set the output destination in 
advance in the plug-in settings.
Plug-in settings►P21 

•	When you use the Watch folder function, files (such 
as P2 MXF, etc.) that have folder structures cannnot be 
converted.

•	When you use the Watch folder function, an external 
device cannot be specified as the output destination.

1	 Double-click the XRE Transcoder icon on the desktop.

Alternative
•	Click the [start] menu, and then click [All Programs] > [Grass Valley] 

> [XRE Transcoder].

2	 Click [Watch folder setting].

The [Watch folder] dialog box appears.
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Alternative
•	Click [Settings] on the menu bar, and then click [Watch folder 

setting].

�� [Watch folder] Dialog Box
(1)(2)(3) (4)

(5)

(1) [Add watch folder] Add a new Watch folder.
(2) [Copy] Copy selected Watch folders from the list.
(3) [Delete] Delete selected Watch folders from the list.
(4) [Post conversion 

request:]
Select an action after conversion of a file from 
the list.

[Move source file]
Move the source file to the “Converted 
Source” folder created in the Watched folder.

[Delete source file]
Delete the source file from the Watched folder.

[None]
No action will be performed.

(5) Watch folder list Added Watch folders are listed, and their 
setting details can be checked and modified. 
Select the check box to activate the Watch folder.

[Watched folder]
The Watched folder is displayed. Click  to 
modify the Watched folder.

[Include subfolders]
Check this option to include subfolders in the 
Watch folder as conversion target.

[Project template]
Check this option to apply project template at 
the time of conversion. Click  to change the 
project template.
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[Format setting]
The exporter name is displayed. Clicking the 

 displays the [Print to File] dialog box where 
you can modify the settings.
[Print to File] Dialog Box►P35 

[Detail setting]
Clicking the  displays the [Detail setting] 
dialog box where you can modify the settings.
[Detail setting] Dialog Box►P48 

[Output folder]
The output destination is displayed. 
Clicking the  allows to modify the output 
destination.

[Preserve relative path]
This option is available when [Include 
subfolders] is checked. Check this option to 
output subfolders of the Watch folder in the 
same folder structures.

3	 Click [Add watch folder].

[New Watch Folder] dialog box appears.

4	 Click [...] of [Watched folder] to select a folder to be watched.

Check [Include subfolders] to include subfolders in the Watch folder as 
conversion target.
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Note •	For the Watched folder, you need to specify a folder that 
can be referenced from all of the PCs for XRE Transcoder/
controller/engine and that shows an identical address on 
the explorer.

5	 To apply a project template at the time of conversion, check 
[Project Template], click [...], and select a project template (*.ezpt).

Applying Project Template at Conversion►P50 

6	 Click [...] of [Format Settings].

The [Print to File] dialog box appears.

[Print to File] Dialog Box►P35 

7	 Click a category in the category tree, and select an exporter.

See "Section 6" for the output formats and exporter list.

Output format►P113 

8	 If the file sizes (frame sizes or frame rates) of source files and 
output files need to be changed, click the expansion button of 
[Advanced] to configure the settings.

[Print to File] (Detailed Settings) Dialog Box►P38 
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9	 Click [OK].

10	 Make output settings in the [Detail setting] dialog box.

�� 	[Detail setting] Dialog Box

(1) [Name] The exporter name is displayed.
The details can be edited. After the details 
has been edited, the changes will be reflected 
on the [Format setting] in the [Watch folder] 
dialog box.

(2) [Description] The explanation of the exporter is displayed.
The details can be edited.

(3) Output settings The configurable items will differ depending 
on the output format.
See the descriptions in "Output Setting for 
Each Format" for more details.
Output Setting for Each Format►P59 

11	 Click [OK].
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12	 In the [New Watch Folder] dialog box, click [...] of [Output] to 
set the output destination.

To output subfolders of the Watch folder in the same folder structures, 
check [Preserve relative path].

To output files to the predefined FTP server or K2 Media server, select 
the server from the list and click [OK].

Note •	You need to specify a folder that can be referenced from 
all of the PCs for XRE Transcoder/controller/engine and 
that shows an identical address on the explorer.

13	 Click [OK] on the [New Watch Folder] dialog box.

14	 Click [OK] on the [Watch Folder] dialog box.  
If a file is added to the Watched folder while XRE Transcoder is 
running, the transcoding job will be registered to XRE. Then the 
conversion process will be performed. The progress status of the 
conversion process can be checked in the job list of XRE Transcoder.

Checking job status►P104 

POINT •	Watch folder settings will be maintained even after XRE 
Transcoder is restarted.
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Applying Project Template at Conversion
You can apply a project template created on EDIUS when converting a 
file with XRE Transcoder.
Project templates can be applied also in the conversion process using 
the Watch folder function.

1	 Create a project template on EDIUS.

Place a clip named “#placeholder” on the timeline and make effect and 
layouter settings.
At the time of conversion with XRE Transcoder, the part 
“#placeholder” will be replaced by the conversion target file.

Editing Example of Project Template (Watermark)►P51 

Editing Example of Project Template (Sidebar Blur)►P53 

Editing Example of Project Template (Playback Speed Change)►P56 
Example) Editing example of timeline

Note •	The number of audio channels of the project template 
must be more than that of the file to be converted.

•	You need to place audio tracks and set the channel map. 
This setting will be used for conversion.

•	The duration of “#placeholder” on the timeline must be 
shorter than the length of the file to be converted.
When the file is converted with XRE Transcoder, the 
duration of “#placeholder” will be expanded along with 
the duration of the file to be converted.
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2	 Click [Save Project] for EDIUS, and then click [Save As 
Template], to save the file to a specified location.

Save the file in a folder that can be accessed from the PC where XRE 
Transcoder has been installed, controller, and all engine PCs, which 
shows the same address on the explorer.

3	 Convert the file with XRE Transcoder.

Specifying and Converting a File►P32 

Converting a File Automatically (Watch folder function)►P44 
The part “#placeholder” of the project template will be replaced by the 
conversion target file.

Editing Example of Project Template (Watermark)
In this section, the procedure to add a watermark (still image) on the 
upper right is described as an example of project template editing on 
EDIUS.

Before conversion
After conversion with project 

template applied

1	 Register a temporary video file to the bin with the name 
“#placeholder”.

2	 Place the “#placeholder” clip in step 1 on the 1VA track of the 
timeline.

Set the duration of the clip shorter than that of the file to be converted.
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3	 Register a watermark image to the bin.

Note •	Since the watermark image is used when a file is 
converted, save the file in a folder that can be accessed 
from all PC/controller/engine where XRE Transcoder has 
been installed, which shows the same address on the 
explorer.

4	 Place the watermark image on the 2V track of the timeline.

5	 Select the clip placed in step 4, and double-click [Layouter] in 
the [Information] palette.

6	 Click the [Transform] tab and drag the operation handle 
in the preview window, to adjust the size of the watermark 
image.
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7	 Drag the watermark image to adjust the position.

8	 Click [OK] on the [Layouter] dialog box.

Editing operation has been completed.

Editing Example of Project Template (Sidebar Blur)
In this section, the procedure to add blur that look natural at both 
sides of a portrait-oriented video shot with a smartphone etc. is 
described as an example of project template editing on EDIUS.

Before conversion
After conversion with project 

template applied 

1	 Register a temporary video file shot with a smartphone etc. to 
the bin with the name “#placeholder”.

2	 Place the “#placeholder” clip in step 1 on the 1VA track of the 
timeline.

Set the duration of the clip shorter than that of the file to be converted.
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3	 Select the “#placeholder” clip on the timeline, and double-
click [Layouter] in the [Information] palette.

[Layouter] dialog box appears.

4	 Click the [Transform] tab and drag the operation handle in the 
preview window, to enlarge the image to the right and left edges.

5	 Click [OK] on the [Layouter] dialog box.
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6	 Apply [Blur] on the [Effects] palette onto the “#placeholder” 
clip (video part) on the timeline.

7	 Double-click [Blur] in the [Information] palette.

8	 Adjust the blur appearance in the [Blur] dialog box and click 
[OK].

9	 Place the “#placeholder” clip in step 1 on the 2V track of the 
timeline.

Editing operation has been completed.
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Editing Example of Project Template (Playback 
Speed Change)
In this section, the procedure to modify the speed is described as an 
example of project template editing on EDIUS.

1	 Register a temporary video file to the bin with the name 
“#placeholder”.

2	 Place the “#placeholder” clip in step 1 on the 1VA track of the 
timeline.

Set the duration of the clip shorter than that of the file to be converted.

3	 Right-click on the “#placeholder” clip on the timeline, and 
click [Time Effect] → [Speed].

4	 Modify each item in the [Speed] dialog box.

�� [Speed] Dialog Box

[Speed] [Direction]
Select the playback direction of the clips.
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[Rate]
Enter the ratio to the original speed (100%).
Since the speed is changed referenced to the 
In point, when [Change the Clip Duration on 
Timeline] is unchecked, the upper limit of 
Rate that can be entered changes according 
to the margin on the Out point side of the 
source clip. When there is no margin on the 
Out point side, a Rate greater than 100% 
cannot be entered.

[Change the 
Clip Duration on 
Timeline]

Check this item to change the duration of 
clips on the timeline according to the speed 
(value of [Rate]) of the clip. The duration 
of the clip can be entered at [Duration] to 
change the speed.
When this item is unchecked, the speed can 
be changed without changing the duration of 
the clip on the timeline.

[Field Option] The [Field Option] dialog box appears.
[Field Option] Dialog Box►P57 

�� [Field Option] Dialog Box

[Interpolation 
Method]

[Nearest neighbor]
The length of the clip is adjusted by skipping 
frames or continuously displaying the same 
frame.
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[Frame blending]
Adjacent frames are composed and a 
new frame is automatically generated to 
interpolate between the frames.

[Optical flow]
The motion in adjacent frames are analyzed 
by pixels and a new frame is automatically 
generated so that the motion of the subject is 
played back smoothly.

[Processing Option] Set the processing option to reduce flicker 
during slow motion. Set [Deinterlace when 
speed is below 100%] when video is affected 
by the scanning line and flickers when a 
slower playback speed has been set.

[Save as default] Click this item to save the current settings 
as defaults. When a clip is placed on the 
timeline, the default [Field Option] is always 
applied.

5	 Click [OK].

Editing operation has been completed.
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Output Setting for Each Format
The output setting screens for each format are described.
In this section, the output setting in "Specifying and Converting a File" 
step 8 is explained.
For the output destination setting in step 12 and the output setting 
of the [Detail setting] dialog box in step 10 in "Converting a File 
Automatically (Watch folder function)", the setting items are the same.

Note •	When you use the Watch folder function, an external 
device cannot be specified as the output destination.

Windows Media Video Format
Category name in [Print to 

File] dialog box
Exporter

[Windows Media] [WindowsMediaVideo]

�� [WindowsMediaVideo] Dialog Box
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[Video settings] [Mode]
[CBR] is a fixed transfer mode. It encodes with a 
constant bitrate regardless of movement or image 
complexity. Enter a value for [Bitrate].
[CBR (2-pass)] performs encoding after an analysis 
for movement and image complexity.
[VBR (quality based)] is a variable transfer mode 
of direct conversion. The allotted bitrate is varied 
according to movement and image complexity. 
Enter a value for [Quality].
[VBR (2-pass)] is a variable transfer mode. The 
allotted bitrate is varied after an analysis of 
movement and image complexity. Enter the average 
bitrate in [Bitrate], and maximum bitrate in [Max].

[Frame rate]
Check this item to change the frame rate (1-60 fps). 
To set to 29.97 fps, enter “2997”.

[Picture size]
The image size can be set by selecting from 
the list. Checking [Square pixel] sets the image 
aspect ratio at 1:1. Check this if the video is 
made vertically long or horizontally long by the 
playback device.

[Quality setting]
Move the slider depending on the relative 
importance of [frame rate  (0)] (prioritizes smooth 
movement) and [image quality  (100)].

[Audio settings] [Mode]
[CBR] is a fixed transfer mode. It encodes with a 
constant bitrate regardless of audio complexity. 
Select a bitrate from the [Bitrate] list.
[CBR (2-pass)] performs encoding after an analysis 
for audio complexity.
[VBR (quality based)] is a variable transfer mode. 
The allotted bitrate is varied according to audio 
complexity. Select an average bitrate from the 
[Quality] list.



XRE Transcoder ―  Users Guide	 61

Output Setting for Each Format

AVI Format
Category name in [Print to 

File] dialog box
Exporter

[AVI] [Grass Valley HQ AVI]
[Grass Valley HQX AVI]
[Grass Valley Lossless AVI]
[DV AVI]
[DVCPRO50 AVI]
[DVCPRO HD AVI]
[Uncompressed (RGB) AVI]
[Uncompressed (RGBA) AVI]
[Uncompressed (UYVY) AVI]
[Uncompressed (YUY2) AVI]
[Uncompressed (v210) AVI]

�� [Grass Valley HQ AVI] / [Grass Valley HQX AVI] Dialog Box

Codec settings [Online(SuperFine)]
This item can be selected for a Grass Valley 
HQX codec. This setting provides the highest 
image quality, though the file size increases. 
Select this when importing at high image 
quality is needed.
This item cannot be selected for a Grass Valley 
HQ codec.

[Online(Fine)]
This setting provides high image quality, 
though the file size increases. Select this when 
importing at high image quality is needed.

[Online(Standard)]
Normally, you can get sufficient image quality 
at this setting.
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[Offline]
Select this item to encode at a lower bitrate.

[Custom]
[Q] and [Max size] can be adjusted.
[Q] adjusts image quality. Set within the range 4 to 
19 (0 to 18 in the case of a Grass Valley HQX).Setting 
a smaller value results in higher image quality.
[Max size] sets the maximum bitrate. You 
can set to limit the file size that increases 
inadvertently as a result of excessive noise in 
the video. Setting value “100” % means the 
same bitrate before codec compression. For 
example, 100% for 1440x1080 59.94i is a bitrate of 
approximately 750 Mbps. To set the upper limit 
to 200 Mbps, set “27” % as the maximum size.

�� [DV AVI] Dialog Box
If [Use MSDV codec] is checked, it will export as AVI with the MSDV 
codec.

Audio Format
Category name in [Print to 

File] dialog box
Exporter

[Audio] [Dolby Digital (AC-3)]
[PCM AIFF]
[PCM WAVE]
[Sony/Sonicfoundry Wave64]

[Windows Media] [WindowsMediaAudio]

�� [Dolby Digital (AC-3)] Dialog Box
Select a bitrate from the [Format] list.

�� [WindowsMediaAudio] Dialog Box
Select the transfer mode. If [CBR] (fixed transfer mode) has been 
selected, select a bitrate from the [Bitrate] list. If [VBR (quality based)] 
(variable transfer mode) has been selected, select a bitrate from the 
[Quality] list.
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Dolby Digital Professional or Dolby Digital Plus Format
Category name in [Print to 

File] dialog box
Exporter

[Audio] [Dolby Digital Professional (AC-3)]
[Dolby Digital Plus (E-AC-3)]

�� [Dolby Digital Professional (AC-3)] / [Dolby Digital Plus 
(E-AC-3)] Dialog Box

[Format] Select the number of bits.
[Settings] Set bitstream details.

[Dolby Setting] Dialog Box►P64 

¾¾Assigning output channels
Output channels are assigned to the front left (L), front right (R), front 
center (C), LFE, rear left (Ls), and rear right (Rs), in the order of the 
smallest channel number. (Channels that are not used will be skipped.) 
When the single rear (S) is to be used, the rear left (Ls) is assigned.
Example:
When [Audio Coding Mode] in the [Dolby Setting] dialog box is set to 
[2/0]

[Dolby Setting] Dialog Box►P64 

[Audio Coding 
Mode]

[LFE 
Channel]*

Stream to be assigned

L R C LFE Ls Rs S

[1/0] ― ― ― Ch1 ― ― ― ―
[2/0] ― Ch1 Ch2 ― ― ― ― ―
[2/1] ― Ch1 Ch2 ― ― ― ― Ch3

 Ch1 Ch2 ― Ch3 ― ― Ch4
[2/2] ― Ch1 Ch2 ― ― Ch3 Ch4 ―

 Ch1 Ch2 ― Ch3 Ch4 Ch5 ―
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[Audio Coding 
Mode]

[LFE 
Channel]*

Stream to be assigned

L R C LFE Ls Rs S

[3/0] ― Ch1 Ch2 Ch3 ― ― ― ―
 Ch1 Ch2 Ch3 Ch4 ― ― ―

[3/1] ― Ch1 Ch2 Ch3 ― ― ― Ch4
 Ch1 Ch2 Ch3 Ch4 ― ― Ch5

[3/2] ― Ch1 Ch2 Ch3 ― Ch4 Ch5 ―
 Ch1 Ch2 Ch3 Ch4 Ch5 Ch6 ―

** indicates that [LFE Channel] in the [Dolby Setting] dialog box is 
checked.

¾¾ [Dolby Setting] Dialog Box

[Audio Coding 
Mode]

Specify the audio channel (front left (L), front 
center (C), front right (R), single rear (S) rear left 
(Ls), rear right (Rs)).
Select an option from [1/0] (C only, monaural), 
[2/0] (L/R, stereo), [2/1] (L/R/S), [2/2] (L/R/Ls/Rs), 
[3/0] (L/C/R), [3/1] (L/C/R/S), [3/2] (L/C/R/Ls/Rs).
The items where the number of channels exceeds the 
audio channels in the source file cannot be selected.
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[LFE Channel] Check this item to export including LFE channel. 
When [Audio Coding Mode] is set to [1/0] or [2/0], 
it cannot be selected.

[Dolby Surround 
Mode]/[Dolby 
Surround Mode EX]*

Set Dolby surround or Dolby Digital surround EX. 
When [Audio Coding Mode] is set to [1/0] or [2/1], 
it cannot be selected.

[Stereo 
Downmix 
Preference]

Can be set when [Audio Coding Mode] is set to 
[3/0], [3/1], or [3/2].

[Not indicated]
Dolby surround mode is not specified.

[Lt, Rt]
Downmix to audio compatible with Dolby 
surround.

[Lo, Ro]
Downmix to audio compatible with stereo or 
monaural playback.

[Pro Logic II]
Downmix in the Dolby Digital Pro Logic II format. 
For Dolby Digital Professional, it cannot be set.

[Center Mix 
Level]

Can be set when [Audio Coding Mode] is set to 
[3/0], [3/1], or [3/2].
Select a value to downmix the center channel 
when the playback device does not have the center 
channel and stereo playback is to be performed. 
Selecting [-INF dB] deletes the center channel.

[Surround Mix 
Level]

Can be set when [Audio Coding Mode] is set to 
[2/1], [2/2], [3/1], or [3/2].
Select a value to downmix the surround channel 
when the playback device does not have the 
surround channel and stereo playback is to 
be performed. Selecting [-INF dB] deletes the 
surround channel.

[Peak mixing 
level]

Specify the peak sound pressure level (SPL) in 
the environment where the final mixing has been 
performed (such as a studio or dubbing stage). 
Select from [111 dB] to [80 dB].
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[Dialog 
Normalization]

Specify the average audio level of the bitstream. 
Specifying this value enables playback of multiple 
audio with the same level on the playback device. 
Select from [-31 dB] to [-1 dB].
The difference between the selected value and 
31 dB is the attenuation when the audio is played 
back on a playback device. Select the audio level 
[-31 dB] from the edited file. 

Example:
For audio of average -6 dB
Set [-6 dB]. The attenuation will be 31 dB – 6 dB = 
25 dB.

Example:
For audio of average -12 dB
Set [-12 dB]. The attenuation will be 31 dB – 12 dB 
= 19 dB.

[Bitstream Mode] Set the audio service included in the bitstream.
[Room type] Specify the information on the environment 

where the final mixing has been performed (such 
as a studio or dubbing stage).

[Dynamic range 
control profile]

Specify the dynamic range compression settings. 
To use [Dynamic range control profile], configure 
[Dialog Normalization] properly.

[A/D converter type] Specify the digital conversion process.
[LFE lowpass 
filter]

Check this item to enable the low-pass filter of the 
LFE channel and to filter audio of 120 Hz or higher.

[90-degree 
phase shift]

Check this item to output in Dolby surround 
compatible audio when downmix playback of multi-
channel audio is performed on a 2-channel decoder.

[3 db attenuation] Check this item to decrease the surround channel 
by 3 dB when home theater equipment compatible 
with multi-channel is used.

[Copyright bit] Check this item to specify that the output file 
contains copyright-protected contents.

[Original 
bitstream]

Check this item to specify that the output file is 
not a copy but an original file.

** If [Audio Coding Mode] is [2/0], [Dolby Surround Mode] is set. If 
[Audio Coding Mode] is [2/2], [3/0], [3/1], or [3/2], [Dolby Surround 
Mode EX] is set.
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HDV Format
Category name in [Print to 

File] dialog box
Exporter

[HDV] [HDV]

�� [HDV] Dialog Box

[Segment 
Encode]

Check this item to export a clip of a raw source 
without re-encoding.
This increases the output speed.
If the frame rate of the export format is 23.98p, 
segment encode is not available.

[Quality/Speed]
Select the quality of the part to be re-encoded 
from the list. The higher the quality, the more 
time it takes to be encoded.

[Gop Type] Only displayed when the export format frame rate 
is 23.98p. Select the format from [HDV24p Record 
(Canon XL-H1, Sony HVR-Z7 etc.)] or [HDV24p 
Scan (Sony HVR-V1, HDV1080i devices)].

QuickTime Format
Category name in [Print to 

File] dialog box
Exporter

[QuickTime] [Apple ProRes MOV]
[QuickTime]
[Grass Valley HQ MOV]
[Grass Valley HQX MOV]
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�� [Apple ProRes MOV] Dialog Box

[Apple ProRes 
CODEC settings]

[Apple ProRes 422 HQ]
High data rate Apple ProRes 422. The target 
data rate for the source 1920 x 1080, 29.97 fps 
is approximately 220 Mbps.

[Apple ProRes 422]
A format suitable for real time editing. The 
target data rate for the source 1920 x 1080, 
29.97 fps is approximately 147 Mbps.

[Apple ProRes 422 LT]
A format suitable for saving the disk storage. 
The target data rate for the source 1920 x 1080, 
29.97 fps is approximately 102 Mbps.

[Apple ProRes 422 Proxy]
A codec for offline workflow. The target data 
rate for the source 1920 x 1080, 29.97 fps is 
approximately 45 Mbps.

�� [QuickTime] Dialog Box

From the [Save as type] list, select a file format and click [Settings].
For detailed settings of output to each file format, refer to the help of 
QuickTime Player.
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�� [Grass Valley HQ MOV] / [Grass Valley HQX MOV] 
Dialog Box

For the setting items, see the descriptions given for [Grass Valley HQ 
AVI] / [Grass Valley HQX AVI] exporter.

[Grass Valley HQ AVI] / [Grass Valley HQX AVI] Dialog Box►P61 

POINT •	If [Grass Valley HQX MOV] or [Grass Valley HQ MOV] is 
set for the exporter, when a project template that satisfies 
all the following conditions is applied, HDR metadata 
will be added to the output data.

--When [Color Space] in [Project Settings] is set to 
[BT.2020/BT.2100 HLG] or [BT.2020/BT.2100 PQ].

--When [Primary Color Correction] is applied, [Source] is 
set to [Auto], and [Destination/LUT] is set to [BT.2020/
BT.2100 HLG] or [BT.2020/BT.2100 PQ].

BD Format
Category name in [Print to 

File] dialog box
Exporter

[H.264/AVC] [Blu-ray]

�� [Blu-ray] Dialog Box

¾¾ [Basic Settings] tab
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[Video settings] [Profile]
Set the profile. The selectable profiles will differ 
dependent on the frame size to be exported.

[Bit Rate Type]
[CBR] assigns a constant number of bits. Although 
noise, etc. may be present, the encoding process is 
made quicker.
[VBR] changes the assigned bitrate according to 
the complexity of the movement or image quality. 
Compared with [CBR], the media volume can 
be used more efficiently, and this enables more 
consistent image quality overall.

[Average]
Set this item if [CBR] or [VBR] has been selected as 
the bitrate type. You can either select from the list 
or enter values directly.

[Max]
Set this item if [VBR] has been selected as the 
bitrate type. You can either select from the list or 
enter values directly.

[Quality]
Select the image quality from the list.

[Use Hardware Encoder]
Check this item to output video using hardware 
encoding such as Quick Sync Video.
Unchecking this item will output video using H.264 
software encoder that enables high-quality and 
high-speed encoding.
In an environment where hardware encoding is 
not available, [Use Hardware Encoder] will not be 
displayed. The encoder for output will be fixed to 
H.264 software encoder.
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[Audio settings] [Format]
Select the audio compression format from the list.
•	For [Dolby Digital (AC-3)] or [Dolby Digital 

Professional (AC-3)]
If the number of audio channels in the source 
file is 7ch or more, the 7th channel and later are 
discarded, and the source file is output with 
5.1ch - 1ch:L, 2ch:R, 3ch:C, 4ch:LFE, 5ch:Ls, and 
6ch:Rs. If the number of audio channels in the 
source file is 5ch or less, all except 1/2ch are 
discarded and the source file is output with 2ch.

•	For [Linear PCM]
If the number of audio channels in the source 
file is 8ch, output is with 8ch; if the number is 
6ch/7ch, output is with 6ch; if the number is 
4ch/5ch, output is with 4ch: and if the number is 
3ch, output is with 2ch.

[Bit Rate]
Select a bitrate from the list.

[Setting]
Set bitstream details.
[Dolby Setting] Dialog Box►P64 

¾¾ [Extended Settings] tab

[IDR Interval] Enter the IDR frame interval, and set the GOP size.
[B Frame] Set the number of B-frames included in one GOP.
[Number of 
Reference 
Frames]

Set up to how many frames to consider when 
motion estimation is performed.



72	 XRE Transcoder ―  Users Guide

Section 5  ― XRE Transcoder Operations

[Multi Slice] Check this item to divide 1 frame into 4 parts. If 
the decoder supports multi-slicing, the decoding 
may be made quicker.

[Entropy Coding 
Mode]

Select the H.264 encoding mode.

[Bit Depth]* Select a video quantization bitrate from the list.
[Chroma 
Format]*

Select a YUV pixel format from the list.

**  Only available when the exporter is [H.264/AVC]. If [Blu-ray], 
[AVCHD], [F4V], or another exporter is to be used, [Bit Depth] is fixed 
to [8], and [Chroma Format] is fixed to [4:2:0].

Note •	If [Bit Depth] is set to [10], or [Chroma Format] is set to 
[4:2:2], hardware encoding cannot be performed even 
when [Use Hardware Encoder] check box is selected in 
[Video settings].

MP4 Format
Category name in [Print to 

File] dialog box
Exporter

[H.264/AVC] [PlayStation Portable]
[H.264/AVC]
[iPod]

POINT •	If [Bit Depth] is set to [10] in the [Extended Settings] tab 
at the time of export, the file will be exported in 10‑bit.

•	If [H.264/AVC] is set for the exporter, When a project 
template that satisfies all the following conditions is 
applied, HDR metadata will be added to the output data.

--When [Color Space] in [Project Settings] is set to 
[BT.2020/BT.2100 HLG] or [BT.2020/BT.2100 PQ]

--When [Primary Color Correction] is applied, [Source] is 
set to [Auto], and [Destination/LUT] is set to [BT.2020/
BT.2100 HLG] or [BT.2020/BT.2100 PQ].

�� [PlayStation Portable] / [H.264/AVC] / [iPod] Dialog Box
For the setting items, see the descriptions given for [Blu-ray] exporter.

[Blu-ray] Dialog Box►P69 
For [PlayStation Portable]/[iPod] exporter, [Size] can be changed in 
[Video settings] of the [Basic Settings] tab.
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MPEG-2 Format
Category name in [Print to 

File] dialog box
Exporter

[MPEG] [MPEG2 Elementary Stream]
[MPEG2 Program Stream]

�� [MPEG2 Elementary Stream] / [MPEG2 Program 
Stream] Dialog Box

If [MPEG2 Elementary Stream] has been selected, click [Select], set the 
audio and video export destinations, and click [OK].

¾¾ [Basic Settings] tab
The setting items displayed may differ in part depending on the 
exporter.
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[Video settings] [Segment Encode]
Check this item to export a clip of a raw source 
without re-encoding.
This increases the output speed.

[Size]
Select an image quality.

[Quality/Speed]
Select quality from the list. The higher the quality, 
the more time it takes to be encoded.

[Bit Rate]
Select a bitrate type.
[CBR] sets a fixed transfer rate, allocating a fixed 
number of bits during the encoding process. 
Select a bitrate from the [Average(bps)] list. You 
can also enter a value directly.
[VBR] sets a variable transfer rate, altering the number 
of assigned bits according to the complexity of the 
movement or image quality. Compared with [CBR], the 
media volume can be used more efficiently, and this 
enables more consistent image quality overall. Select 
a bitrate from the [Average(bps)] and [Maximum(bps)] 
lists. You can also enter a value directly.

[Audio settings] [Format]
Select the audio compression format from the list.

[Channel]
Select from [Stereo], [Dual Channel] or [Joint Stereo]. 
[Stereo] is normal stereo that records separately on 
the left and right sides. If there is a large difference 
between the left and right audio, compared to stereo 
that saves audio with a greater focus on one side, [Dual 
Channel] records totally independently so that there 
is no bias in sound quality to one side. Select to enter 
narration in 2 languages, etc. [Joint Stereo] improves 
audio quality and compression ratio when recording 
left and right audio separately by automatically using 
a single channel that combines the audio when the left 
and right sides are the same or one more channel when 
the left and right audio are different.

[Bit Rate (bps)]
Select a bitrate from the list.
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¾¾ [Extended Settings] tab

[Video settings] [Field Order]
For interlace, a field order can be selected.

[Chroma Format]
Select a YUV pixel format from the list.

[Profile & Level]
Select a profile & level. If [Chroma Format] is 
[4:2:0] and [4:2:2], the profile will be set to Main 
Profile and 422Profile, respectively. The level for 
SD image quality will be Main Level, and the level 
for HD image quality will be High Level. The 
profile & level changes according to the format 
selected in [Chroma Format].

[GOP Structure]
For MPEG, a certain number of frames is 
considered as a group, and operations such as 
compression/enlargement and cut editing are 
performed on a GOP basis. A GOP comprises “I 
frame”, “P frame” and “B frame”. The I frame 
allows images to be reproduced independently, 
the P frame is for recording and reproducing only 
the differences with the preceding image, and the 
B frame reproduces images from the differences 
in the preceding and following images. Select I, 
P and B frame patterns of the GOP from the list. 
Normally, select [IBBP].
[I-Frame Only] is comprised of only I-pictures. 
Editing is made easier, but the amount of data 
increases in size.
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[Picture count]
Set the number of frames included in a group.

[Closed GOP]
Check this item to complete information within 
each GOP. Although the amount of data increases, 
the video can be re-edited using software that 
supports GOP-based editing. Normally, leave this 
item unchecked.

[Audio settings] [Emphasis]
Select from the list for high-frequency 
compensation that saves while emphasizing 
the high range. With [None], there is no high-
frequency compensation. [50/15 us] is an emphasis 
setting employed by some audio CDs, etc. 
[CCITT J.17] is a telecommunications standard 
recommended by CCITT.

[Protection]
The “protection_bit” indicates whether 
redundancy is added to an audio stream in order 
to make error detection and correction possible. 
Check this item to change it to “1”, indicating that 
redundancy is being added. Uncheck this item to 
change it to “0”, indicating that redundancy is not 
being added.

[Original Flag]
Check this item to change the “original_copy” 
bit to “1”, indicating the original copy. If it 
is unchecked, it becomes “0”, indicating a 
duplication.

[Copyright Flag]
Check this item to change the “copyright” bit to 
“1”, indicating that the copyright is protected. If 
it is unchecked, it becomes “0”, indicating there is 
no copyright.
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Flash Video (F4V) Format
Category name in [Print to 

File] dialog box
Exporter

[H.264/AVC] [F4V]

�� [F4V] Dialog Box

¾¾ [Basic Settings] tab/[Extended Settings] tab
For the setting items, see the descriptions given for [Blu-ray] exporter.

[Blu-ray] Dialog Box►P69 

¾¾ [Metadata] tab

[Export 
sequence marker 
as cue point]

Check this item to export sequence markers as cue 
points for Flash. Select the name of the type of cue 
point.

[Metadata] Export is possible with metadata appended.
Select an item from the [Name] list, and enter 
metadata at [Value].

[Import] Import XMP format (*.xmp) metadata. This is 
reflected in the [Metadata] setting.

[Export] Export the settings made at [Metadata] in XMP 
format.

H.265/HEVC Format
Category name in [Print to 

File] dialog box
Exporter

[H.265/HEVC] [H.265/HEVC]
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�� [H.265/HEVC] Dialog Box
For the setting items, see the descriptions given for [Blu-ray] exporter.

[Blu-ray] Dialog Box►P69 

AVCHD Format
Category name in [Print to 

File] dialog box
Exporter

[AVCHD] [AVCHD] (When exported to a file)
[AVCHD Writer] (When exported to 
removable media)

Note •	When exporting to the internal hard disk, internal 
memory or removable disk of an AVCHD camera for 
playback on the AVCHD camera, you may be unable to 
perform the export or playback depending on the camera.

•	Depending on the type of save destination, a warning message 
may be displayed saying that data will become unrecognizable. 
Be sure to create a backup before export, as required.

•	If a stream file size exceeds 2 GB, it will be split up before 
export.

�� [AVCHD Writer] Dialog Box

[Destination] [Drive]
Select this option to output files to an SD 
memory card or Memory Stick.

[Folder]
Select this option to output AVCHD stream files 
to a selected destination. Click [Browse] to set 
the destination.

[Format] Select according to the media being used.
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�� Common Settings for [AVCHD Writer] / [AVCHD] Dialog Box

¾¾ [Basic Settings] tab/[Extended Settings] tab
For the setting items, see the descriptions given for [Blu-ray] exporter.

[Blu-ray] Dialog Box►P69 

XDCAM EX Format
Category name in [Print to 

File] dialog box
Exporter

[XDCAM] [XDCAM EX DV]
[XDCAM EX]

Note •	Be sure to format the SxS memory card with the XDCAM 
EX device in advance.

�� [XDCAM EX] / [XDCAM EX DV] Dialog Box
The setting items will differ depending on the exporter.
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[Destination] Select whether to export to an SxS memory card, 
to export to an SDHC memory card or to save 
to a desired folder. A file is exported in a folder 
structure.
If [Sony - SxS Memory Card] or [JVC - SDHC 
Memory Card] is selected, select a card from the list.
If [Automatically select the next card when card 
is full.] is checked, when free space runs out 
on the SxS memory card selected as the export 
destination, an SxS memory card with free space 
will be selected automatically and exported to. If 
it is unchecked, a dialog box will be displayed to 
select the export destination.
If [Folder] has been selected, click [...] and specify 
a save destination.

[Segment 
Encode]

Check this item to export a clip of a raw source 
without re-encoding. This increases the output 
speed.

[ClosedGOP] Check this item to complete information within 
each GOP. Although the amount of data increases, 
the video can be re-edited using software that 
supports GOP-based editing.

[Audio/Stereo] Check this item to export the audio as a stereo 
track. This is only displayed when the audio 
channel is 2ch.

[Mode] Select an image quality mode (SP or HQ).
[Quality/Speed] Select quality from the list. The higher the quality, 

the more time it takes to be encoded.
Metadata Add metadata such as title and comments to clips 

to be exported.

¾¾ [Select Memory Card Drive] Dialog Box
When the clip is to be split, a dialog box appears to select the export 
destination.

[Memory Card]: 
[L]/[R]

Select the next memory card drive.

[OK] Click this item after selecting a drive or after 
replacing a memory card.



XRE Transcoder ―  Users Guide	 81

Output Setting for Each Format

GF Format
Category name in [Print to 

File] dialog box
Exporter

[GF] [GF clip]
[GF clip (DV)]
[GF clip (DVCPRO25)]
[GF clip (DVCPRO50)]
[GF clip (SD)]

Note •	If a clip consists of files with a size that exceeds 4 GB, it 
will be split up before export.

[GF clip] / [GF clip (DV)] / [GF clip (DVCPRO25)] / [GF clip 
(DVCPRO50)] / [GF clip (SD)] Dialog Box
The setting items will differ depending on the exporter.

[Destination] Select whether to export to a GF drive or save to a 
desired folder.
If [GF Drive] has been selected, select a Drive from 
the list.
If [Folder] has been selected, click [Select] and 
specify a save destination.

[Bin]
Set the BIN in which to register the exported clip. 
Select from the list, or click [Append], enter a BIN 
title and register anew to the list.

[Clip Title] Enter the name of the clip to be exported.
[Segment 
Encode]

Check this item to export a clip of a raw source 
without re-encoding. This increases the output 
speed.
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[Gop Type] Select the GOP type from [I-Frame Only(100 
Mbps)] or [Long GOP(50 Mbps)].

[Quality/Speed] Select a quality.
[Bit Rate] Select a bitrate from the list.
[Audio Channels] Select the number of audio channels.
[Audio 
Quantization Bit 
Rate]

Select an audio quantization bitrate.

Infinity Format
Category name in [Print to 

File] dialog box
Exporter

[Infinity] [Infinity DV]
[Infinity JPEG2000]
[Infinity D10]
[Infinity MPEG]

�� [Infinity MPEG] / [Infinity DV] / [Infinity JPEG2000] / 
[Infinity D10] Dialog Box

The setting items will differ depending on the exporter.

[Destination] Select whether to export to an Infinity drive or 
save to a desired folder.
If [Infinity Drive] has been selected, select a Drive 
from the list.
If [Folder] has been selected, click [Select] and 
specify a save destination.

[Clip Name] Enter the name of the clip to be exported.
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[Playlists] Select whether the playlist name has the same 
name as the clip name. If [Specified the playlist.] 
has been selected, enter a playlist name.

[Segment 
Encode]

Check this item to export a clip of a raw source 
without re-encoding. This increases the output speed.

[Bit Rate] Select a bitrate from the list.
[Quality/Speed] Select a quality.
[Audio Format] Select an audio quantization bitrate and a number 

of audio channels from the list.

P2 Format
Category name in [Print to 

File] dialog box
Exporter

[P2] [HD P2 Clip]
[AVCUltra P2 Clip]
[P2 Clip]

Note •	Make sure that the P2 device drivers are already 
installed.

•	Audio will be exported in 16‑bit format audio, even if the 
source file is set to 24‑bit format audio.

•	If there is no more free space in the export destination, or 
if the clip consists of files with a size that exceeds 4 GB, it 
will be split up before export.

•	If exporting at 720p, the export frames must be even 
frames. If a confirmation message appears, select a 
processing method.

•	If a DVCPRO HD export format and the settings content 
for the source file differ, the export data will be stretched 
before export so that the frame rate and the field order 
correspond to each other.
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�� [HD P2 Clip] / [AVCUltra P2 Clip] / [P2 Clip] Dialog Box
The setting items will differ depending on the exporter.

[Destination] Select whether to export to a P2 drive or save to a 
desired folder.
If [P2Card] has been selected, select a Card from 
the list.
If [Folder] has been selected, click [Select] and 
specify a save destination.

[User Clip 
Name]

Enter the name of the clip to be exported.

[Video settings] Select a codec from the list.
[Audio settings] Select an audio quantization bitrate.
Metadata Click on a tab to input metadata.
[Automatically 
select the next 
card when card 
is full.]

If you check this item, when the clip is split, a 
P2 card drive that has free space will be selected 
automatically and exported to. If it is unchecked, 
when the clip is split, a dialog box will appear to 
select the export destination.

[Load Metadata] Metadata, such as the created by and capture 
information, can be imported from another P2 
clip. Click [Load Metadata] and select the XML file 
to be imported.
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XDCAM Format
Category name in [Print to 

File] dialog box
Exporter

[XDCAM] [XDCAM DV]
[XDCAM MPEG IMX]
[XDCAM HD]
[XDCAM HD 422]
[XDCAM HD 720P]

Note •	Be sure to format the SxS memory card with an XDCAM 
device in advance.

•	Files cannot be exported to an SxS memory card 
formatted in the XDCAM EX format.

•	Proxy files will not be exported.
•	If a clip is exported that does not include high-resolution 

or proxy data, a dialog box will appear to set the 
processing before export. Select a processing method and 
click [OK].

•	If [XDCAM MPEG IMX] was selected, 3 lines (black) 
will be added above and below the 720x480 video to be 
exported as Even (Top Field First).
Also, 720x576 (Odd) video will be shifted by 1 line to be 
exported as Even (Top Field First).

�� [XDCAM HD] / [XDCAM DV] / [XDCAM MPEG IMX] / 
[XDCAM HD 422] / [XDCAM HD 720P] Dialog Box

The setting items will differ depending on the exporter.
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[Destination] Select whether to export to an XDCAM drive, 
to an FTP server, or to a desired folder. A file is 
exported in a folder structure.
If [XDCAM Drive] was selected, select a Drive 
from the list.
If [FTP] was selected, check the server to be 
exported to and, as necessary, check the item 
described below.
If [Folder] was selected, click [Select] and specify a 
save destination.

[Upload to FTP after exporting file.]
Check this item to export a temporary file to the 
project folder, and then upload the actual data to 
an FTP server. After outputting the temporary 
file, if an error occurs during transfer to the FTP 
server or if the upload is aborted, the temporary 
file will not be deleted.

[Clip Name] Set the file name to be exported.
If [Auto (C****)]  is checked, a file name will be set 
automatically. To set a preferred file name, remove 
the check from [Auto (C****)] and enter a name 
in [Clip Name]. (“Clip Naming” must be set as 
“Free” on the XDCAM drive.)

[Segment 
Encode]

Check this item to export a clip of a raw source 
without re-encoding. This increases the output 
speed.

[Bit Rate] Select a bitrate from the list.
[Quality/Speed] Select a quality.
[ClosedGOP] Check this item not to use the B-picture at the 

GOP border as reference across GOPs. Although 
the amount of data increases, the video can be 
re-edited using software that supports GOP-based 
editing, as the information is completed within 
each GOP.

[Audio Format] Select the audio format to export.
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XAVC S Format
Category name in [Print to 

File] dialog box
Exporter

[XAVC] [XAVC S]

POINT •	If a project template that satisfies all the following 
conditions is applied, HDR metadata will be added to 
the output data.

--When [Color Space] in [Project Settings] is set to 
[BT.2020/BT.2100 HLG] or [BT.2020/BT.2100 PQ].

--When [Primary Color Correction] is applied, [Source] is 
set to [Auto], and [Destination/LUT] is set to [BT.2020/
BT.2100 HLG] or [BT.2020/BT.2100 PQ].

Registering Exporter Settings as Preset►P102 

Note •	Be sure to format the XQD memory card with an XAVC S 
device in advance.

�� [XAVC S] Dialog Box

[Destination] Select whether to export to an XAVC S device or 
to a desired folder. A file is exported in a folder 
structure.
If [Memory Card] is selected, select a device from 
the list.
If [Folder] is selected, click [...] and specify a save 
destination.
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[Video Settings] [Bit Rate]
Select a bitrate from the list.

[Quality]
Select an image quality.

[Use Hardware Encoder]
Check this item to output video using hardware 
encoding such as Quick Sync Video.
Unchecking this item will output video using H.264 
software encoder that enables high-quality and high-
speed encoding.
In an environment where hardware encoding is 
not available, [Use Hardware Encoder] will not be 
displayed. The encoder for output will be fixed to 
H.264 software encoder.

[Audio Settings] Select the audio format of the video to be exported.
Metadata Add metadata such as title and comments to clips 

to be exported.

XAVC Format
Category name in [Print to 

File] dialog box
Exporter

[XAVC] [XAVC]

POINT •	If a project template that satisfies all the following 
conditions is applied, HDR metadata will be added to 
the output data.

--When [Color Space] in [Project Settings] is set to 
[BT.2020/BT.2100 HLG] or [BT.2020/BT.2100 PQ].

--When [Primary Color Correction] is applied, [Source] is 
set to [Auto], and [Destination/LUT] is set to [BT.2020/
BT.2100 HLG] or [BT.2020/BT.2100 PQ].

Registering Exporter Settings as Preset►P102 

Note •	Be sure to format the SxS memory card with an XDCAM 
device in advance.

•	Files cannot be exported to an SxS memory card 
formatted in the XDCAM EX format.
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�� [XAVC] Dialog Box

[Destination] Select whether to export to an XDCAM drive, 
to an FTP server, or to a desired folder. A file is 
exported in a folder structure.
If [XDCAM Drive] was selected, select a drive 
from the list.
If [FTP] was selected, check the server to be 
exported to and, as necessary, check the item 
described below.
If [Folder] was selected, click [Select] and specify a 
save destination.
[Upload to FTP after exporting file.]
Check this item to export a temporary file to the 
project folder, and then upload the actual data 
to an FTP server. After exporting the temporary 
file, if an error occurs during transfer to the FTP 
server or if the upload is aborted, the temporary 
file will not be deleted.

[Clip Name] Set the file name to be exported.

[Auto (C****)]
If it is checked, a file name will be set 
automatically. To set a preferred file name, remove 
the check from [Auto (C****)] and enter a name 
in [Clip Name]. (“Clip Naming” must be set as 
“Free” on the XDCAM drive.)

[Format] Select the format to export.
[Quality/Speed] Select quality and speed.
[Audio 
Channels]

Select the number of audio channels.
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K2 (GXF) Format
Category name in [Print to 

File] dialog box
Exporter

[K2] [AVCIntra GXF]
[AVCUltra GXF]
[D10 GXF]
[DNxHD GXF]
[DV GXF]
[DVCPRO25 GXF]
[DVCPRO50 GXF]
[DVCPROHD GXF]
[JPEG2000 GXF]
[MPEG2 GXF]

Note •	Audio will be exported in 16-bit format audio, even if the 
source file is set to 24-bit format audio.

[MPEG2 GXF] / [AVCIntra GXF] / [AVCUltra GXF] / [D10 
GXF] / [DNxHD GXF] / [DV GXF] / [DVCPRO25 GXF] / 
[DVCPRO50 GXF] / [DVCPROHD GXF] / [JPEG2000 GXF] 
Dialog Box
The setting items will differ depending on the exporter.
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[Clip Name] Enter the name of the clip (file) to be exported.
[Destination] Select whether to export to a desired folder or to 

an FTP server.
If [Folder] was selected, click [Select] and specify a 
save destination.
If [FTP] was selected, check the server to be 
exported to and, as necessary, check the items 
described below.

[Overwrite file when it exists]
Check this item to overwrite a file if the file with 
the same file name is present at the FTP server of 
the export destination.

[Upload to FTP after exporting file]
Check this item to export a temporary file to the 
project folder, and then upload the actual data to 
an FTP server. After outputting the temporary 
file, if an error occurs during transfer to the FTP 
server or if the upload is aborted, the temporary 
file will remain undeleted.

[Do not add file extension when exporting to FTP]
Check this item to export a file without adding the 
file extension to the name entered in [Clip Name]. 
(If [Clip Name] contains a file extension, export 
will take place with a clip file name with its file 
extension removed.)
When this item is unchecked, export will take 
place with the “*.gxf” file extension added if the 
name entered in [Clip Name] does not include the 
file extension.

[Keep the 
created file 
when aborting]

Becomes enabled if [Upload to FTP after exporting 
file] is unchecked.
If it is checked and export is aborted, the file 
created up to the time point of the abort will 
remain at the export destination.
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[Encode 
Settings]

[Segment Encode]
Check this item to export a clip of a raw source 
without re-encoding.
This increases the output speed.

[Bit Rate]
Select a bitrate type.
[CBR] sets a fixed transfer rate, allocating a fixed 
number of bits during the encoding process. Enter 
an average bitrate in [Average].
[VBR] sets a variable transfer rate, altering 
the number of assigned bits according to the 
complexity of the movement or image quality. 
Enter the average bitrate in [Average], and 
maximum bitrate in [Max].

[Quality/Speed]
Select quality from the list.

[Field Order]
The field order can be selected if it is in SD format.

[GOP structure]
Select I, P and B frame patterns of the GOP from 
the list. Normally, select [IBBP].
[I-Frame Only] is comprised of only I-pictures. 
Editing is made easier, but the amount of data 
increases in size.

[Picture count]
Enter the number of frames included in 1 GOP.

[Closed GOP]
If it is checked, the GOP will be closed. Although 
the amount of data increases, the video can be 
re-edited using software that supports GOP-based 
editing, as the information is completed within 
each GOP. Normally, leave this item unchecked.
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[Chroma Format]
Select a YUV pixel format from the list.

[Profile/Level]
Select a profile & level. If [Chroma Format] is 
[4:2:0] and [4:2:2], the profile will be set to Main 
Profile and 422Profile, respectively. The level for 
SD image quality will be Main Level, and the level 
for HD image quality will be High Level. The 
profile & level changes according to the format 
selected in [Chroma Format].

[Bit Rate] Select a bitrate from the list.
[Format] Select the format to export.
[Audio Settings] [Channels]

Select the number of audio channels you want 
to export from the list. [Current setting] is the 
number of channels configured in the source file. 
If [Enable Conversion] is checked for the exporter 
and the number of channels for the audio format 
is changed from the source file, the number of 
channels will be the number set here.

[Quantization Bit Rate]
Select the number of bits to be used during 
sampling. [Current setting] is the number of bits 
configured in the source file.
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K2 (CMF) Format
Category name in [Print to 

File] dialog box
Exporter

[K2] [K2 AVCIntra Clip]
[K2 AVCUltra Clip]
[K2 AVCHD Clip]
[K2 D10 Clip]
[K2 DNxHD Clip]
[K2 DV Clip]
[K2 DVCPRO HD Clip]
[K2 MPEG2 Clip]

Note •	Files in 1280x720 50p and 1280x720 59.94p formats which 
have odd number of frames cannot be output.

�� Common Settings for [K2 AVCIntra Clip] / [K2 AVCUltra 
Clip] / [K2 AVCHD Clip] / [K2 D10 Clip] / [K2 DNxHD 
Clip] / [K2 DV Clip] / [K2 DVCPRO HD Clip] / [K2 
MPEG2 Clip] Dialog Box

[Clip Name] Enter a clip name for the file to be exported.
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[Destination] [Server]
Select a file export destination from the list.

[Bin]
Displays the list of bins in the save destination 
you selected in [Server].

[Overwrite file when it exists]
Check this item to overwrite a file if any file 
with the same clip name is already registered in 
the bin in the export destination.

[Sequence 
Settings]

[Export as a program sequence]
Check this item to export sequences as 
programs.

[Audio Settings] [Channels]
Select the number of audio channels you want 
to export from the list.

[Quantization Bit Rate]
Select an audio quantization bitrate from the 
list.

�� [Video Settings] in the [K2 MPEG2 Clip]/ [K2 DV Clip]/ 
[K2 AVCIntra Clip]/ [K2 AVCUltra Clip] Dialog Box

The setting items will differ depending on the exporter.

[Format] Select an export format from the list.
[Segment Encode] Check this item to export a clip of a raw source 

without re-encoding.
This increases the output speed.

[Quality/Speed] Select quality from the list.
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[Bit Rate] Select a bitrate type.
[CBR] sets a fixed transfer rate, allocating a fixed 
number of bits during the encoding process.
Select a bitrate from the [Average] list. You can 
also enter a value directly.
[VBR] sets a variable transfer rate, altering 
the number of assigned bits according to the 
complexity of the movement or image quality. 
Compared with [CBR], the media volume can 
be used more efficiently, and this enables more 
consistent image quality overall. Select a bitrate 
from the [Average] and [Maximum] lists. You 
can also enter a value directly.

[GOP structure] For MPEG, a certain number of frames is 
considered as a group, and operations such as 
compression/enlargement and cut editing are 
performed on a GOP basis. A GOP comprises “I 
frame”, “P frame” and “B frame”. The I frame 
allows images to be reproduced independently, 
the P frame is for recording and reproducing 
only the differences with the preceding image, 
and the B frame reproduces images from the 
differences in the preceding and following 
images. Select I, P and B frame patterns of the 
GOP from the list. Normally, select [IBBP].
[I-Frame Only] is comprised of only I-pictures. 
Editing is made easier, but the amount of data 
increases in size.

[Picture count] Set the number of frames included in a group.
[Closed GOP] Check this item to complete information 

within each GOP. Although the amount of data 
increases, the video can be re-edited using 
software that supports GOP-based editing. 
Normally, leave this item unchecked.

[Chroma Format] Select a YUV pixel format from the list.
[Profile/Level] Select a profile & level. If [Chroma Format] is 

[4:2:0] and [4:2:2], the profile will be set to Main 
Profile and 422Profile, respectively. The level for 
SD image quality will be Main Level, and the 
level for HD image quality will be High Level. 
The profile & level changes according to the
format selected in [Chroma Format].
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�� [Video Settings] in the [K2 D10 Clip]/ [K2 DNxHD Clip] 
Dialog Box

[Bit Rate] Select a bitrate from the list.

�� [Video Settings] in the [K2 AVCHD Clip] Dialog Box

[Profile] Set the profile. The selectable profiles will differ 
depending on the frame size to be exported.

[Bit Rate Type] [CBR] assigns a constant number of bits. 
Although noise, etc. may be present, the 
encoding process is made quicker.
[VBR] changes the assigned bitrate according 
to the complexity of the movement or image 
quality. Compared with [CBR], the media 
volume can be used more efficiently, and this 
enables more consistent image quality overall.

[Average] Set this item if [CBR] or [VBR] has been selected 
as the bitrate type. You can either select from 
the list or enter values directly.

[Max] Set this item if [VBR] has been selected as the 
bitrate type. You can either select from the list 
or enter values directly.

[Quality] Select the image quality from the list.
[IDR Interval] Enter the IDR frame interval, and set the GOP 

size.
[B Frame] Set the number of B-frames included in one 

GOP.
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[Multi Slice] Check this item to divide 1 frame into 4 parts. 
If the decoder supports multi-slicing, the 
decoding may be made quicker.

[Entropy Coding 
Mode]

Select the H.264 encoding mode.

[Number of 
Reference Frames]

Set up to how many frames should be 
considered when motion estimation is 
performed.

[Motion Estimation 
Precision]

Select the unit of division for the motion 
estimation block from the list.

[Minimum Block 
Size of Prediction]

Set the block size during motion estimation for 
intra-frames/inter-frames.

MXF Format
Category name in [Print to 

File] dialog box
Exporter

[MXF] [MPEG2 Legacy MXF]
[AVCIntra MXF]
[AVCUltra MXF]
[D10 MXF]
[DNxHD MXF]
[DV MXF]
[DVCPRO25 MXF]
[DVCPRO50 MXF]
[DVCPROHD MXF]
[HQ MXF]
[HQX MXF]
[JPEG2000 MXF]
[MPEG2 MXF]
[ProRes MXF]

POINT •	If a project template that satisfies all the following 
conditions is applied, HDR metadata will be added to 
the output data.

--When [Color Space] in [Project Settings] is set to 
[BT.2020/BT.2100 HLG] or [BT.2020/BT.2100 PQ].

--When [Primary Color Correction] is applied, [Source] is 
set to [Auto], and [Destination/LUT] is set to [BT.2020/
BT.2100 HLG] or [BT.2020/BT.2100 PQ].

Registering Exporter Settings as Preset►P102 
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�� [MPEG2 Legacy MXF] / [MPEG2 MXF] / [AVCIntra 
MXF] / [AVCUltra MXF] / [D10 MXF] / [DNxHD MXF] 
/ [DV MXF] / [DVCPRO25 MXF] / [DVCPRO50 MXF] 
/ [DVCPROHD MXF] / [HQ MXF] / [HQX MXF] / 
[JPEG2000 MXF] /[ProRes MXF] Dialog Box

The setting items will differ depending on the exporter.

[Clip Name] Enter the name of the clip (file) to be exported.
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[Destination] Select whether to export to a desired folder or to 
an FTP server.
If [Folder] was selected, click [Select] and specify a 
save destination.
If [FTP] was selected, check the server to be exported 
to and, as necessary, check the items described below.

[Overwrite file when it exists]
Check this item to overwrite a file if the file with 
the same file name is present at the server of the 
export destination. Uncheck this item to display a 
confirmation message.

[Upload to FTP after exporting file]
Check this item to export a temporary file to the project 
folder, and then upload the actual data to an FTP server. 
After outputting the temporary file, if an error occurs 
during transfer to the FTP server or if the upload is 
aborted, the temporary file will not be deleted.

[Do not add file extension when exporting to FTP]
Check this item to export a file without adding the file 
extension to the name entered in [Clip Name]. (If [Clip 
Name] contains a file extension, export will take place 
with a clip file name with its file extension removed.)
Uncheck this item to export a file with the “*.mxf” 
added if the name entered in [Clip Name] does 
not include the file extension.

[Keep the 
created file 
when aborting]

Becomes enabled if [Upload to FTP after exporting 
file] is unchecked.
When this item is checked, the file being uploaded 
will be completed if an upload is aborted.

[Encode 
Settings]

[Segment Encode]
Check this item to export a clip of a raw source 
without re-encoding.
This increases the output speed.

[Bit Rate]
Select a bitrate type.
[CBR] sets a fixed transfer rate, allocating a fixed 
number of bits during the encoding process. Enter 
an average bitrate in [Average].
[VBR] sets a variable transfer rate, altering the 
number of assigned bits according to the complexity 
of the movement or image quality. Enter the average 
bitrate in [Average], and maximum bitrate in [Max].
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[Quality/Speed]
Select quality from the list.

[Field Order]
The field order can be selected if it is in SD format.

[GOP structure]
Select I, P and B frame patterns of the GOP from 
the list. Normally, select [IBBP].
[I-Frame Only] is comprised of only I-pictures. 
Editing is made easier, but the amount of data 
increases in size.

[Picture count]
Enter the number of frames included in 1 GOP.

[Closed GOP]
If it is checked, the GOP will be closed. Although 
the amount of data increases, the video can be 
re-edited using software that supports GOP-based 
editing, as the information is completed within 
each GOP. Normally, leave this item unchecked.

[Chroma Format]
Select a YUV pixel format from the list.

[Profile/Level]
Select a profile & level. If [Chroma Format] is [4:2:0] 
and [4:2:2], the profile will be set to Main Profile 
and 422Profile, respectively. The level for SD image 
quality will be Main Level, and the level for HD 
image quality will be High Level. The profile & level 
changes according to the format selected in [Chroma 
Format].

[Bit Rate] Select a bitrate from the list.
[Format] Select the format to export.
[HQX CODEC 
settings]

For the setting items, see the descriptions given 
for [Grass Valley HQ AVI] / [Grass Valley HQX 
AVI] exporter.
[Grass Valley HQ AVI] / [Grass Valley HQX AVI] 
Dialog Box►P61 
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[Audio settings] [Channels]
Select the number of audio channels you want 
to export from the list. [Current setting] is the 
number of channels configured in the source file. 
If [Enable Conversion] is checked for the exporter 
and the number of channels for the audio format 
is changed from the source file, the number of 
channels will be the number set here.

[Quantization Bit Rate]
Select the number of bits to be used during 
sampling from the list. [Current setting] is the 
number of bits configured in the source file.

[Channels Per Track]
Specify the number of channels to be included in 
1 audio track for MXF.

[Type]
Select the audio format to export.

[System Type] Select a system item format.
[KAG Size] Select a KAG (KLV Alignment Grid) size.
[Operational 
Pattern]

Select Operational Pattern from the list.

Registering Exporter Settings as Preset
An exporter setting can be registered as a preset exporter.

1	 Select an exporter in the [Print to File]/[Print to File] dialog box.
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2	 If necessary, select the check box of [Enable Conversion] and 
click the expansion button of [Advanced] to configure the 
settings.

[Enable Conversion] is not displayed in the [Print to File] dialog box.

[Print to File] (Detailed Settings) Dialog Box►P38 

3	 Click [Save preset] in the [Print to File] dialog box.

[Preset Dialog] will be displayed.

4	 Enter a preset exporter name in [Preset name], and configure 
the export details.

The export contents differ depending on the exporter.

POINT •	You can enter your preferred description in 
[Description]. It will be displayed at the exporter/preset 
list in the [Print to File] dialog box.

5	 Click [OK].

The created preset is registered in the exporter/preset list.

POINT •	When you click [My presets] in the category tree, all 
user-registered exporter presets are displayed in the 
exporter/preset list.

•	To change the settings of already-created exporter 
presets, select the preset exporter to be changed, click 
[Save preset] and change the settings.
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Checking job status
The progress status and history of jobs can be checked in the job list of 
XRE Transcoder.
If it is running on the controller, the “management mode” is active. In 
the management mode, you can reorder the jobs to be executed.
The job list shows not only the jobs requested by XRE Transcoder, but 
jobs requested by EDIUS.

1	 Double-click the XRE Transcoder icon on the desktop.

If XRE Transcoder is already started and the XRE Transcoder icon 
is in the task tray, right-click on the icon and then click [Open XRE 
Transcoder].

Alternative
•	Click the [start] menu, and then click [All Programs] > [Grass Valley] 

> [XRETranscoder].

�� 	[XRE Transcoder] Dialog Box

(16)

(19)

(17)

(1)

(15)

(18)

(2)

(3)
(4)

(5)
(6)

(7)
(8)

(9)
(10)

(11)
(12) (14)

(13) (20)

(1) Menu bar The menu bar also allows you to perform the 
operations from (2) to (14) in the table.
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(2) [Add job] Specify a desired file and request conversion 
process (transcode job) to the controller.
Specifying and Converting a File►P32 

(3) [Restart]* Click this button to restart a job after selecting a 
paused or stopped job from the [Job List (above)].

(4) [Pause]* Pauses the job you selected from the [Job List 
(above)].

(5) [Stop]* Stops the job you selected from the [Job List 
(above)].

(6) [Cancel]* Cancels the job you selected from the [Job List 
(above)]. The canceled job will move to the  
[Job List (below)].

(7) [Retry]* Performs the job you selected from the [Job 
List (below)] again.

(8) [Property] Shows the properties of the job you selected 
from the [Job List (above)] or [Job List (below)].
Checking job properties►P107 

(9) [Change job order]
(management 
mode only)

Turns on/off the job sorting.
Sorting the order to perform jobs in XRE 
Transcoder (management mode)►P109 

(10) [Up]
(management 
mode only)

Moves up the order to perform the job you 
selected from the [Job List (above)].
Sorting the order to perform jobs in XRE 
Transcoder (management mode)►P109 

(11) [Down]
(management 
mode only)

Moves down the order to perform the job you 
selected from the [Job List (above)].
Sorting the order to perform jobs in XRE 
Transcoder (management mode)►P109 

(12) [Settings] Configure settings in [Server setting], [Error 
notification], and [Watch Folder].
Configuring XRE Transcoder►P16 

(13) [Plug-in 
settings]

Configure the plug-in settings.
Plug-in settings►P21 

(14) [Watch folder 
setting]

Configure the Watch folder settings.
Converting a File Automatically (Watch folder 
function)►P44 

(15) [Server] The currently connected controller is 
displayed. Clicking the list shows the list of the 
controllers stored as destinations, which allows 
you to switch the controller to check job status.
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(16) Job List (above) Shows the active jobs and jobs waiting to be 
performed.

(17) [Error]/[Info] Choose the job history types to be shown. To 
show all of the job history, click both of them.

[Error]
Click this to show only jobs in which errors 
occurred.

[Info]
Click this to show jobs in which no error 
occurred (successful and canceled ones).

(18) [Search] Enter a keyword to narrow down the search 
result of the [Job List (below)].

(19) Job List (below) Shows the history of the performed jobs.
A successful job is shown with , a job in 
which an error occurred is shown with , 
and a canceled job is shown with .
The number of days to keep the history can be 
configured on the XRE Management Server.

(20) Close Closes the [XRE Transcoder] dialog box.

** On PCs other than for the controller, only the user who has requested 
the job can perform operations regarding their own job.

POINT •		If [Change job order] is turned off, every click on an 
item name in the [Job List (above)] can sort the rendering 
jobs in ascending or descending order. Sorting is not 
available if [Change job order] is turned off. Sorting is 
available in the [Job List (below)] whether [Change job 
order] is turned on or off.

•		Displayed items can be customized. Right-click on an 
item name, and then check the item(s) to display.
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About error notifications
If an error occurs during job process, an error message appears near 
the task tray. 

If you click the error message, it disappears.

POINT •		You can check the type of errors you will be notified of 
and change it.
Configuring XRE Transcoder►P16 

•	You will not be notified of error details. You can check 
them in the [Job List (below)] of the [XRE Transcoder] 
dialog box. A job in which an error occurred is shown 
with .
[XRE Transcoder] Dialog Box►P104 

Checking job properties
1	 Select a job from the [Job List (above)] or [Job List (below)], 

and then click [Property].

Alternative
•	Select a job from the [Job List (above)] or [Job List (below)], and then 

click [Action] > [Property] from the menu bar.
•	Select a job from the [Job List (above)] or [Job List (below)], right-click 

on it, and then click [Property].
•	Double-click a job in the [Job List (above)] or [Job List (below)].
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�� [Job Properties]

¾¾ [General] tab

POINT •		You can configure the [Job Name], [Priority], and 
[Comment] settings for a job in the [Job List (above)].

•		In XRE Transcoder (management mode), you can change 
the [Job Name], [Priority], and [Comment] settings for 
all jobs. On PCs other than for the controller, only the 
user who has requested the job can change [Job Name], 
[Priority], and [Comment] of their own job.

•		Properties of a job in the [Job List (below)] cannot be 
changed. When viewing properties of a job in the [Job 
List (below)], [History] appears in the dialog box caption.
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¾¾ [Details] tab

You can view the properties of the next upper or lower job from the 
currently displayed one by clicking  or .

Sorting the order to perform jobs in XRE Transcoder 
(management mode)

Note •	On PCs other than for the controller, job reordering 
cannot be performed.

1	 Click [Change job order] to turn it on.

Every click switches on and off.
When set to on, the button appears in blue and job, indicating that 
reordering is enabled.

Ex. When turned on 

POINT •	If job sorting is enabled, jobs are sorted by the order in 
which they are performed.
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Alternative
•	Click [Action] > [Change job order] from the menu bar. A check mark 

appears if job sorting is enabled.
•	Right-click on a job in the [Job List (above)] or [Job List (below)], and 

then click [Change job order]. A check mark appears if job sorting is 
enabled.

2	 Select a job from the [Job List (above)], and then click either 
[Up] or [Down].

Alternative
•	Select a job from the [Job List (above)], and then click [Action] > [Up] 

or [Down] from the menu bar.
•	Select a job from the [Job List (above)], right-click on it, and then click 

[Up] or [Down].
•	Select a job from the [Job List (above)], and then drag and drop the 

job in the upper or lower direction.
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Supported Format

Section 6
Appendix
Supported Format

Input format

�� Video
Format File extension

3GP *.3gp, *.3g2
ASF *.asf
AVCHD *.m2ts, *.mts
AVI File *.avi
CompuServe GIF Files *.gif
DIF stream *.dif, *.dv
DPX (SMPTE 268M-2003) Files *.dpx
F4V *.f4v
ICO Decoder *.ico, *.icon
JPEG Decoder *.jpe, *.exif
JPEG File Interchange Format Files *.jfif
JPEG Files *.jpg, *.jpeg
MOV *.mov
MP4 *.mp4, *.m4v
MPEG HDD MOVIE *.mod, *.tod
MPEG Program Stream *.mpg, *.mpeg, *.m2p, *.mp2, *.vob, *.vro
MPEG Transport Stream *.m2t
MPEG Video Stream *.mpv, *.m2v
MXF *.mxf
Maya IFF *.iff
Multi-PictureFormat *.mpo
Photoshop Files *.psd
Portable Network Graphics Files *.png
Quick Titler *.etl
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Format File extension

RED File *.R3D
SGI Files *.sgi, *.rgb
Sony HVR-DR60/HVR-MRC1 Meta File *.idx
TIFF Files *.tif, *.tiff
Targa Files *.tga, *.targa, *.vda, *.icb, *.vst
Transport Stream *.ts
WMPhoto Decoder *.wdp, *.jxr
Windows Bitmap Files *.bmp, *.dib, *.rle
Windows Media *.wmv, *.asf
Windows Meta Files *.wmf, *.emf
XF Clip File *.cif
Spanned clips such as for P2 or XDCAM *.xml

** When you use the Watch folder function, spanned clips such as for P2 cannot be specified as 
source files.

�� Audio
Format File extension

AAC  *.aac, *.m4a
AIFF*¹ *.aiff, *.aif
Dolby Digital (AC-3) *.ac3
Dolby Digital Professional (AC-3) *.ac3
Dolby Digital Plus (E-AC-3) *.ec3
MPEG Audio Layer-3*² *.mp3
MPEG Audio Stream *.mpa, *.m2a
Ogg Vorbis file *.ogg

Wave *.wav
Windows Media Audio *.wma

*1 �AIFF/AIFC files are PCM only.
*2 �Some VBR are not supported.
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�� Formats Added at Installation of QuickTime
Format File extension

3GPP Files *.3gp, *.3g2, *.amc
AAC Files *.aac, *.m4a
Flash Pix Files *.fpx
Flash Video *.f4v
MPEG4 File *.mp4, *.m4v
Mac Pict Files *.pic, *.pct, *.pict 
QuickTime Image Files *.qtif, *.qti, *qif
QuickTime Movie *.mov

Output format

�� Video

Note •	Some formats may not support codec.
•	Depending on the device specifications and compatibility, playback and output on 

the device may not be supported.

Format/
container

Codec
File 

extension

Category 
name in 

[Print to File] 
dialog box

Exporter Page

AVCHD ― *.m2ts [AVCHD] [AVCHD] ►P78

[AVCHD Writer]
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Format/
container

Codec
File 

extension

Category 
name in 

[Print to File] 
dialog box

Exporter Page

AVI Grass Valley HQ *.avi [AVI] [Grass Valley HQ AVI] ►P61

Grass Valley HQX [Grass Valley HQX AVI]
Grass Valley Lossless [Grass Valley 

Lossless AVI]
DV [DV AVI]
DVCPRO50 [DVCPRO50 AVI]
DVCPRO HD [DVCPRO HD AVI]
Uncompressed (RGB) [Uncompressed 

(RGB)AVI]
Uncompressed 
(RGBA)

[Uncompressed 
(RGBA)AVI]

Uncompressed 
(UYVY)

[Uncompressed 
(UYVY)AVI]

Uncompressed 
(YUY2)

[Uncompressed 
(YUY2)AVI]

Uncompressed (v210) [Uncompressed 
(v210)AVI]

Blu-ray H.264/AVC *.m2ts [H.264/AVC] [Blu-ray] ►P69

Flash Video H.264/AVC *.f4v [H.264/AVC] [F4V] ►P77

GF MPEG-2 I-frame only *.xml 
+ *.mxf

[GF] [GF clip] ►P81

MPEG-2 Long GOP
DV [GF clip (DV)]
DVCPRO25 [GF clip 

(DVCPRO25)]
DVCPRO50 [GF clip 

(DVCPRO50)]
SD [GF clip (SD)]

H.264/AVC H.264/AVC *.mp4 [H.264/AVC] [H.264/AVC] ►P72

HDV MPEG-2 Transport 
Stream

*.m2t [HDV] [HDV] ►P67

H.265/HEVC H.265/HEVC *.mp4 [H.265/
HEVC]

[H.265/HEVC] ►P77
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Format/
container

Codec
File 

extension

Category 
name in 

[Print to File] 
dialog box

Exporter Page

Infinity DV *.xml 
+ *.mxf

[Infinity] [Infinity DV] ►P82

JPEG2000 [Infinity JPEG2000]
D10 [Infinity D10]
MPEG [Infinity MPEG]

iPod H.264/AVC *.mp4 [H.264/AVC] [iPod] ►P72

K2 (CMF) AVC-Intra50 *.xml [K2] [K2 AVCIntra Clip] ►P94

AVC-Intra100
AVC-LongG [K2 AVCUltra Clip]
AVCHD [K2 AVCHD Clip]
D10 [K2 D10 Clip]
DNxHD [K2 DNxHD Clip]
DV [K2 DV Clip]
DVCPRO HD [K2 DVCPRO HD 

Clip]
MPEG-2 [K2 MPEG2 Clip]

K2 (GXF) AVC-Intra50 *.gxf [K2] [AVCIntra GXF] ►P90

AVC-Intra100
AVC-LongG [AVCUltra GXF]
D10 [D10 GXF]
DNxHD [DNxHD GXF]
DV [DV GXF]
DVCPRO25 [DVCPRO25 GXF]
DVCPRO50 [DVCPRO50 GXF]
DVCPRO HD [DVCPROHD GXF]
JPEG2000 [JPEG2000 GXF]
MPEG-2 [MPEG2 GXF]

MPEG-2 Video 
Elementary 
Stream

MPEG-2 *.m2v [MPEG] [MPEG2 Elementary 
Stream]

►P73

MPEG-2 
Program 
Stream

MPEG-2 *.mpg, 
*.m2p

[MPEG] [MPEG2 Program 
Stream]

MP4 H.264/AVC *.mp4 [H.264/AVC] [H.264/AVC] ►P72
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Format/
container

Codec
File 

extension

Category 
name in 

[Print to File] 
dialog box

Exporter Page

MXF AVC-Intra50 *.mxf [MXF] [AVCIntra MXF] ►P98

AVC-Intra100
AVC-Intra200
AVC-LongG [AVCUltra MXF]
D10 [D10 MXF]
DNxHD [DNxHD MXF]
DV [DV MXF]
DVCPRO25 [DVCPRO25 MXF]
DVCPRO50 [DVCPRO50 MXF]
DVCPRO HD [DVCPROHD MXF]
Grass Valley HQ [HQ MXF]
Grass Valley HQX [HQX MXF]
JPEG2000 [JPEG2000 MXF]
MPEG-2 [MPEG2 MXF]

[MPEG2 Legacy 
MXF] 

Apple ProRes [ProRes MXF]

P2 AVC-Intra50 *.xml 
+ *.mxf

[P2] [HD P2 Clip] ►P83

AVC-Intra100
AVC-Intra200
AVC-LongG [AVCUltra P2 Clip]
AVC-Intra 4K 422
DV [P2 Clip]
DVCPRO25
DVCPRO50
DVCPRO HD [HD P2 Clip]

PlayStation 
Portable

H.264/AVC *.mp4 [H.264/AVC] [PlayStation 
Portable]

►P72
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Format/
container

Codec
File 

extension

Category 
name in 

[Print to File] 
dialog box

Exporter Page

QuickTime Apple ProRes *.mov [QuickTime] [Apple ProRes MOV] ►P67

QuickTime [QuickTime]*¹
Grass Valley HQ [Grass Valley HQ 

MOV]
Grass Valley HQX [Grass Valley HQX 

MOV]
WindowsMedia ― *.wmv [Windows 

Media]
[WindowsMediaVideo] ►P59

XAVC XAVC Intra *.xml 
+ *.mxf

[XAVC] [XAVC] ►P88

XAVC Long GOP
XAVC S*² *.xml 

+ *.mp4
[XAVC S] ►P87

XDCAM DVCAM *.xml 
+ *.mxf

[XDCAM] [XDCAM DV] ►P85

MPEG IMX [XDCAM MPEG 
IMX]

MPEG HD [XDCAM HD]
MPEG HD422 [XDCAM HD 422]
MPEG HD 720P [XDCAM HD 720P]

XDCAM EX DVCAM *.xml 
+ *.mp4

[XDCAM] [XDCAM EX DV] ►P79

MPEG HD [XDCAM EX]
DV DV .dv [DV] [DV stream] ―

*1 �If QuickTime has been installed, the following output formats are available. 
[3G], [AIFF], [Apple TV], [AU], [AVI], [DV stream], [FLC], [iPhone], [iPhone (Cellular)], [iPod], 
[MPEG-4], [QuickTime Movie], [Wave], [Image Sequence]

*2 �To load medium where a file has been exported to the camera, perform [Restore Media] on the 
camera. Thumbnails cannot be displayed on the camera.
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�� Audio

Format/container
File 

extension

Category name 
in [Print to File] 

dialog box
Exporter Page

Dolby Digital (AC-3) *.ac3 [Audio] [Dolby Digital (AC-3)] ►P62

AIFF *.aif, *.aiff [Audio] [PCM AIFF]
Wave *.wav [Audio] [PCM WAVE]
Sony/Sonicfoundry Wave64 *.w64 [Audio] [Sony/Sonicfoundry 

Wave64]
Windows Media Audio *.wma [Windows 

Media]
[WindowsMediaAudio]

Dolby Digital Professional 
(AC-3)

*.ac3 [Audio] [Dolby Digital 
Professional (AC-3)]

►P63

Dolby Digital Plus (E-AC-3) *.ec3 [Audio] [Dolby Digital Plus (E-
AC-3)]

MPEG-1 Audio Elementary 
Stream

*.mpa [MPEG] [MPEG2 Elementary 
Stream]

►P73

Restrictions
•	Still images (including still images with increment numbers) cannot be specified as output 

formats.
•	When you use the Watch folder function, spanned clips such as for P2 cannot be specified as 

source files.
•	When you use the Watch folder function, an external device cannot be specified as the output 

destination.
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